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About ThisManual

The LabWindows/CVI Test Executive Toolkit Reference Manual describes the LabWindows/CVI
add-on package you can use for automated sequencing of test programs.

Organization of ThisManual

This manual is organized as follows:

Chapter 1, Introduction, describes the installation procedure and lists the main features of the
Test Executive Toolkit. It aso explains the execution model of the toolkit and the three
operating levels.

Chapter 2, Getting Started, introduces the basic concepts of test executive operation and test
sequence devel opment.

Chapter 3, Operating the Test Executive, shows how to use the Test Executive main panel—the
controls, indicators, and operator dialog boxes. The main panel is the user interface for both
development and run-time operation.

Chapter 4, Creating Tests and Test Sequences, describes the process of creating new functions
and sequences for execution by the Test Executive.

Chapter 5, Modifying the Test Executive, describes the internal structure of and how to modify
the Test Executive.

Chapter 6, Function Descriptions for the Test Executive, describes the functionsin the Test
Executive engine.

Appendix A, Error Codes and Engi ne Constants, lists the error codes and other important
constants used by the Test Executive engine.

Appendix B, Customer Communication, contains forms you can use to request help from
National Instruments or to comment on our products and manuals.

The Glossary contains an alphabetical list and description of terms used in this manual, including
abbreviations, acronyms, metric prefixes, mnemonics, and symbols.

The Index contains an aphabetical list of key terms and topics in this manual, including the page
where you can find each one.

© National Instruments Cor poration Xi LabWindows/CVI Test Executive Toolkit



About This Manual

ConventionsUsed in ThisManual

The following conventions are used in this manual:

bold Bold text denotes parameters, or the introduction of menu or function panel
items.

italic Italic text denotes emphasis, a cross reference, or an introduction to a key
concept.

nonospace  Textinthisfont denotestext or characters that are to be literally input from the
keyboard, sections of code, programming examples, and syntax examples. This
font is also used for the proper names of disk drives, paths, directories,
programs, subprograms, subroutines, device names, functions, variables,
filenames, and extensions, and for statements and comments taken from
program code.

italic Italic text in this font denotes that you must supply the appropriate
nmonospace  word or value in the place of these terms—for example, i | enane.

<Ctrl> Key namesin the text match the names on the keys. For example, the Control
key appears in the text as <Ctrl>.

- A hyphen between two or more key names denotes that you should
simultaneously press the named keys—for example, <Ctrl-Alt-Del>.

Related Documentation
The following documents contain information that you may find helpful as you read this manual:
* Your Getting Sarted with LabWindows/CVI manual

e Your LabWindows/CVI User Manual

Customer Communication

National Instruments wants to receive your comments on our products and manuals. We are
interested in the applications you develop with our products, and we want to help if you have
problems with them. To make it easy for you to contact us, this manual contains comment and
technical support forms for you to complete. These forms are in the Appendix B, Customer
Communication, at the end of this manual.

LabWindows/CVI Test Executive Toolkit Xii © National Instruments Cor poration



Chapter 1
| ntroduction

This chapter describes the installation procedure and lists the main features of the Test Executive
Toolkit. It also explains the execution model of the toolkit and the three operating levels.

| nstallation

The following section contains instructions for installing the Test Executive on the Windows and
Sun SPARCstation platforms.

The LabWindows/CV1 Test Executive comes in compressed form on afloppy disk. Installing the
Test Executive requires approximately 1.2 MB.

Some virus detection programs may interfere with the installer program. Check the distribution
disk for viruses before you begin installation. Then turn off the automatic virus checker and run

theinstaller. After installation, it isgood practice to check your hard disk for viruses again and
then turn on the virus checker.

Windows

You caninstall the Test Executive from the Windows File Manager or with the Run... command
from the File menu of the Program Manager.

Insert the Test Executive Toolkit disk into the 3.5-inch disk drive and run the SETUP. EXE
program using one of the following three methods.

» Under Windows, launch the File Manager. Click on the driveicon that contains the
installation disk. Find SETUP. EXE inthelist of files on that disk and double-click on it.

* Under Windows, select Run... from the File menu of the Program Manager. A dialog box
appears. Type X: \ SETUP (where X isthe proper drive designation).

After you choose an installation option, follow the instructions that appear on the screen.

© National Instruments Cor poration 11 LabWindows/CVI Test Executive Toolkit



Introduction Chapter 1

SPARCstation

Perform the following stepsto install the Test Executive. Y ou do not need root privileges to
install the Test Executive, but you must be able to write to the LabWindows/CV1 directory where
the Test Executive will be installed.

1. Connect to the LabWindows/CVI directory.
2. Insert the Test Executive disk into the 3.5-inch disk drive.
3. Typethefollowing UNIX command: t ar xvf /dev/fdO

After you install the LabWindows/CVI Test Executive, your LabWindows/CV1 directory should
contain anew t est exec directory.

Updating Sequence Paths

If you installed the Test Executive on a SPARCstation or in a non-default directory under MS-
Windows, you must perform the following steps to update the paths in the sequence files so that
you will be able to run the example sequences.

1. Start LabWindows/CVI and open and run the project t est exec. prj . When the Login
dialog box appears, type the word devel oper inthe password box and click on OK. The
main panel of the Test Executive appears.

2. Choose Open... from the File menu and select thefile conput er . squ inthe Load Test
Sequence dialog box.

Note: You can ignore any error messages which begin Unabl e to verify test..

3. Select Edit Sequence... from the Sequence menu. The Sequence Editor appears.

4. Inthe Sequence Editor, click on the Edit Paths... button. The Edit Paths dialog box appears.
5. Perform the following steps for each item in the Current Paths in Sequence list box.

a Select theitem and click on Update Selected File.... The Select Replacement dialog
box appears.

b. Inthedialog box that appears, select the file name that matches the file you selected in
the Current Paths in Sequence list box and click on OK.

6. Click on OK in the Edit Paths dialog box and then click on OK in the Sequence Editor.
7. Select Save from the File menu in the Test Executive main panel.

8. Choose Open... from the File menu. Update the sequence paths for each of the example
sequence files as described in the preceding steps.

LabWindows/CVI Test Executive Toolkit 1-2 © National Instruments Cor poration



Chapter 1 Introduction

Product Overview

The LabWindows/CV1 Test Executive Toolkit creates an automated test system. This add-on
package includes a complete Test Executive that can perform many standard operations. The
toolkit includes source code, so you can change or expand the functionality.

The Test Executive runs test programs using C functions. The following are the main features of
the Test Executive.

» Test sequencing based on pass/fail status, preconditions, and goto commands
* Logging of test results
* Generating ASCII test reportsto file

* Run-time interfacing, including prompts for operator and (UUT) Unit Under Test serial
number, Pass and Fail banners, and run-time error notification

» Forcing individual tests to pass, fail, or skip for test sequence debugging
» Halting and looping on individual test failure

» Testing continuously in UUT mode

* Running pre- and post-run routines for system setup and shutdown

» Using three operating levels

© National Instruments Cor poration 1-3 LabWindows/CVI Test Executive Toolkit



Introduction Chapter 1

Execution Mod€

The Test Executive can execute a sequence in one of three ways—UUT Test, Single Pass, or
Single Test. The UUT Test, invoked when the operator clicks on the Test UUT button, executes
atest sequence repetitively. Each test cycle includes a UUT serial number prompt and Pass,
Fail, and Abort banners to notify the operator of the test result for the current UUT.

UUT Test mode is the production operating mode for testing multiple UUTs. You use Single
Pass mode primarily during development and sometimes for diagnostic purposes. In Single Pass
mode, the test sequence executes only once, and you are not prompted for the UUT serid
number or with the Pass, Fail, and Abort banner display. The following illustration shows the
overall flow of executionin UUT Test and Single Pass operation.

UUT Info !

Skip if in
Single Pass mode

Sequence Setup

Test Setup

Run Test Loop until: No more tests, Loop if in
user stop, or run-time error Test UUT mode

A

Test Cleanup

Sequence Cleanup

Skip if in
Single Pass mode

Show Banner

Ll

Figure 1-1. Flowchart for UUT Test and Single Pass Operation

In addition to UUT Test and Single Pass operation, you can choose Single Test execution to run
an individual test. You should use Single Test execution primarily for diagnostic purposes.
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Chapter 1 Introduction

Operating Levels

The Test Executive has three operating levels—Developer, Technician, and Operator. The
following table summarizes the capabilities available in each operating level.

Table 1-1. Text Executive Operating Levels

Leve UUT Test Single Pass/Single Test Edit Sequences
Developer Yes Yes Yes
Technician Yes Yes No
Operator Yes No No

At the Developer level, you have accessto all capabilities of the Test Executive.

At the Technician level, you can run individual tests, but you cannot edit sequences. Y ou can
also run a sequence in Single Pass mode. The Technician level gives you the flexibility to
execute tests to diagnose a UUT.

The Operator level isthe most restrictive, in that you can execute only test sequencesin UUT
Test mode by selecting the Test UUT button.

When you load the Test Executive, set the operating level by typing one of three passwordsin
the Login dialog box: devel oper ,t echni ci an, or oper at or . Whilethe Test Executive
runs, you can change the operating level by re-opening the Login dialog box under the File
menul.

Development Model

The LabWindows/CV I Test Executive is a completely functional, ready-to-run test executive.
Chapter 3, Operating the Test Executive, describes the operation of the test executive at the
highest level.

The Test Executive is contained in the LabWindows/CV1 project filet est exec. prj . You
may want to make copies of t est exec. prj with different names for each of your
development efforts.

t est exec. prj isaproject file that contains all the source code files for the Test Executive.

Y ou can build a standalone executable from the t est exec. prj file. You caninclude your
test functions as source codefilesinthe t est exec. prj fileand when you create a standalone
executable. However, programmers normally maintain their tests as separate object or library
files, keeping them separate from the Test Executive. Because LabWindows/CVI executes your
tests using the Utility Library functions LoadExt er nal Modul e and
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CGet Ext er nal Modul eAddr , you can develop and distribute the object or library files for
your tests separately from the standalone executable.

You can makethet est exec. prj project into a standalone executable without modification.
Later, you develop tests independently, using LabWindows/CV1, and save them as object or
library files. The Test Executive can load these tests dynamically, leaving the executable
unchanged.

Perform the following steps to develop your test functions for the LabWindows/CVI Test
Executive.

1. Develop each new test as a C function in source code. In order to integrate your test properly
with the Test Executive, your test functions must follow the prototypes shown in the
LabWindows/CVI exampletests. (Thefilet enpl at e. ¢ contains standard prototypes.)

2. Temporarily add your source code filesto the project (t est exec. prj ) so that you can test
them using the source code debugging features of LabWindows/CV1.

3. Compile the source code into an object module using LabWindows/CV1 or the Watcom,
Borland, or Symantec 32-bit C compilers.

4. Remove the source code files from the project file.

Y ou use the Sequence Editor of the Test Executive to create atest sequence that contains your
tests. In the Sequence Editor, you can configure the run options and test preconditions that
control the flow of your test sequence. Y ou can also specify the name of the test function and
thefileinwhich it exists.

Chapter 4, Creating Tests and Test Sequences, tells you how to create new test functions and test
sequences. When you want to customize the LabWindows/CV1 Test Executive, you can modify
the Test Executive project file in LabWindows/CVI. Refer to the project file t est exec. prj
which listsall of the. ui r filesand object modules for the Test Executive. The project file also
shows you the source code files that correspond to the object modules, but the system ignores
these source code files when you build an executable. If you want to modify any of the source
code files for the Test Executive, include the appropriate source code file in the project list and
exclude the corresponding object files.

Chapter 5, Modifying the Test Executive, covers the following topics:
* Organization of source code files

*  Common modifications

* Advanced modifications

» Writing atest executive

If you want to write your own test executive, the instrument driver library—specificaly, the
LabWindows/CV1 Test Executive Enginein thefiles t xengi ne. * —gives you a starting point.
Chapter 6, Function Descriptions for the Test Executive Engine, describes the functions you can
use to build your test executive engine.
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Getting Started

This chapter introduces the basic concepts of test executive operation and test sequence
development, and contains the following examples.

» Operating a Test Sequence

* Examining a Test Function

» Editing a Test Sequence

Y ou should go through these examples in the order they are presented. The first example,
Running a Test Sequence, is relevant to anyone who operates the Test Executive. The second
two examples, Examining a Test Function and Editing a Test Sequence, are for users who write

test functions and create test sequences.

The Test Executive comes with four test sequence examples, which are described at the end of
this chapter.

This chapter assumes that you are running the Test Executive within the LabWindows/CV |

environment. If you are executing the Test Executive as an standal one application, you can only
use the first example—Running a Test Sequence.

Operating a Test Sequence
Starting the Test Executive
Perform the following steps to start the Test Executive.

1. Launch LabWindows/CVI.

2. Open the Test Executive project, which can befoundint est exec. prj to start the Test
Executive. The setup program places thisfilein the TESTEXEC directory.

3. Runthe Test Executive by choosing Run Project from the Run menu. The Login dialog
box appears.
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4. Typeinyour name and password as shown in the following illustration.

=-| CVl Test Executive Login

Login Name:
John Smith |

Password:

| | Cancel

Figure 2-1. Login Dialog Box
The Password field sets the operating level of the Test Executive. For this session, you will start
the Test Executive at the Operator level, so type oper at or inthe Name and Password fields.
Note: You can access the Operator level by typing any text in the Password field. However,
you must type t echni ci an to accessthe Technician level and devel oper to access
the Developer level.

5. Click on OK to confirm your entries.
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On the Test Executive front panel, notice the word Stopped that appears next to the large LED.
This LED isthe Status indicator. Stopped indicates that no test sequence is currently running.
Y our screen appears as shown in the following illustration.

= Lab¥indows/C¥l Test Executive - ||~
File Heport Sequence Test

Description: Sequence File: Login Level: 10-04-20

[ | [Mo Sequence | [Operator | 09-21-1994

Sequence Display: Test Dizplay:
+ +*

+]
ojic: 5]
Yest 3T 1 Abest
At Loon StDppEd
|:| Stop on Failure Llear Vel Siaduy

Figure 2-2. Test Executive Front Panel in Stopped Mode

Running a Test Sequence
Perform the following steps to run a test sequence.
1. Select Open... from the File menu.

2. Sdlect the file COMPUTER. SQU, which can be found in the EXAMPLES subdirectory of the
TESTEXEC directory.

When you load COMPUTER. SQU, notice that the test sequence appears in the Sequence
Display to execute the sequence. Also, the name of the test sequence appears at the top of
the Test Executive main panel.

3. Click onthe Test UUT button located beneath the Sequence Display to execute the
sequence. The Test Executive prompts you for the serial number of the UUT.
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4. Type 123 intheinput box and click on the OK button. The simulator asks you to specify
which tests, if any, will fail. Select afew of the tests and then click on Done. The sequence
executes.

As the sequence executes, notice the following events on your screen.
» The Statusindicator displays RUNNI NGwith aflashing LED.

* Aseachtest runs, the word RUNNI NG appears next to the name of the active test in the
Sequence Display.

» After eachtest runs, the Pass, Fail, or Skip status of the test appears next to the name of
the test in the Sequence Display, and the test result appearsin the Test Display.

When the sequence execution completes, a banner appears indicating whether the UUT
passed, failed, or was aborted.

5. Click on OK in the completion banner, and enter another serial number when the UUT
Information dialog box appears. The Test Executive continuesto cycle to the next UUT until
you click on Stop in the UUT Information dialog box.

6. To view thetest report after execution completes, choose View from the Report menu. The
report appearsin the Test Display string indicator.

The Test Report includes the name and description of the sequence, the date and time that testing
began, the operator's name, and the results of testing for each UUT. When you set this test
sequence to generate a test report file, the system automatically writes the test report to the file
each time the sequence executes.

Changing to Technician L evel

Perform the following steps to change from Operator to Technician level and to see the more
flexible execution capabilities at the Technician level.

1. Select Login... from the File menu.

2. Inthe Login dialog box, typethewordt echni ci an inthe Password field and click on
OK. The Single Pass, Run Test, and Loop Test buttons appear in the lower left corner of
the Test Executive front panel.

3. If you do not see these buttons, select Login... from the File menu again and carefully type
thewordt echni ci an inthe Password field again.

How to Run Single Tests and Use Single Pass M ode
To run asingle test, click on the name of the desired test and then the Run Test button. Notice
that only the selected test runs. Single Test execution selectively runsindividual tests for

diagnosis and troubleshooting. The test status appears next to the test name in the Sequence
Display. Y ou can also execute atest repeatedly by clicking on the Loop Test button.
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Now click on the Single Pass button. Clicking on this button runs the entire test sequence one
time without the UUT prompts and banners. Notice that the sequence stops after it executes one
time. When you select View from the Report menu, the Test Executive generates the Test
Report asit did at the Technician level.

Exiting The Test Executive

Select Exit from the File menu to stop execution of the Test Executive.

Examining a Test Function

The following example shows you a simple function that you can execute in a test sequence.
Y ou need to study this example only if you write test functions and incorporate them into the
Test Executive. Y ou need LabWindows/CVI programming experience to complete this
example. More information on test functions and sequencing appears in Chapter 4, Creating
Tests and Test Sequences.

Perform the following steps to learn about how atest function is built.

1. Launch LabWindows/CVI if you have not already done so, but do not run the Test Executive
yét.

2. Find and open the sourcefile r andom c, located in the TESTEXEC/ EXAMPLES directory.

The Randomfunction in thisfileillustrates the basic structure of a functioning test function in
the Test Executive. Randomneeds two parameters, data and error, as shown in the following
code segment.

voi d Randon(t TestData *data, tTestError *error)
{
doubl e measurenent, limt;
srand(cl ock());
[imt = (double)rand() / RAND_MAX;
measur enent = (doubl e)rand() / RAND_MNAX;
error->errorFl ag=FALSE;
if (limt >= nmeasurenent)
dat a->result = PASS;
el se
data->result = FAIL;
dat a- >neasur enent = measur enent;
dat a- >out Buffer = mal | oc(100);
sprintf(data->outBuffer,"measurenent %, limt %",
measurenent, limt);
}

Thet Test Dat a structure transmits information about the result of thetest. Thet Test Err or
structure transmits information the Test Executive uses for run-time error handling. In this
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example, you use Randomasif it were anewly created test function to step through the test
sequence creation process.

Randomgenerates two random numbers, limit and measurement. The function compares
measurement to limit, setting the r esul t member inthet Test Dat a structure to the result of
the comparison. This function also passes one of the random numbers and a comment as the
nmeasur erent and out Buf f er membersof thet Test Dat a structure. When you create a
test sequence that calls this function later in this chapter, you will see how these structure
members are used.

3. Closer andom c. Do not save any changes.

Y ou can now use this test function to create a test sequence.

Editing a Test Sequence
The following steps show you how to set up and edit atest sequence.
1. Launch LabWindows/CVI1 if you have not already done so.

2. Runthe Test Executive. Type devel oper inthe Password field of the Login dialog box
and click on OK .

3. Select Edit Sequence... from the Sequence menu to invoke the Sequence Editor.
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Notice that the list box at the top of the Sequence Editor dialog box is empty. Thislist box
shows the tests that are defined for the current sequence. Use the Sequence Editor to input
all of the specifications required to define atest sequence.

= Test Executive Sequence Editor n “
Test File Function Input Reszult Comp.
+ Edit I
]
Test Attributes Edit Paths... I
Test Name:
.
Eunction Mame: File Hame: Ingert Below I
| I | [_setect Fite... |
Limit Specification:
o m— -
Input Buffer: .
| | | Fun Options... || Setup/Cleanup. .. I ancet Edity
Sequence Attributes ’D—EI
| Test Preconditions.__ I | Deszcription. . ” Setup/Cleanup. _. || Report._.. I
Cancel I L

Figure 2-3. Sequence Editor Dialog Box

4. To add tests to a sequence, you enter parameters in the Test Attributes controls located below
the Sequence Editor list box. Click in the control labeled Test Name. In this example, you
add the Randomfunction to a new sequence and configure its limit specifications. Type
Random Bool ean inthe Test Name control.

5. Click on the Select File button to choose the file containing the function you want to run for
thistest. For thisexample, select r andom obj . Now type Randomin the Function Name
control.

To determineif atest passes or fails, the Test Executive must have alimit specification. The
Test Executive looks at the t Test Dat a structure of the test function and applies the limit
checking you specify in the sequence editor to each test. Thet Test Dat a structure
contains both a Boolean flag and a numeric measurement. Y ou can use either of these
elements to determine if the function passes.

6. Click onthe Set Limit... button to view the Set Limit Specification dialog box. Scroll

through the Comparison Type ring control to see the available types of checking. If you
choose a numeric comparison, you must also enter the numeric limits used for the
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comparison. For this example, set Comparison Typeto BOCL. Your Set Limit Specification
dialog box should look like the following illustration.

Companson type:
BOOL

Mo comparizson done by Test Executive - Test
sets Boolean Fag to indicate PASS/FAIL state.

Figure 2-4. Set Limits Specification Dialog Box

Setting Comparison Type to BOOL setsthe Test Executive to use the result flag in the
t Test Dat a structure to determine if the test passed or failed.

7. Click on OK to confirm the limit specification. The Limit Specification control should now
contain the text { BOOL} .

8. Click on Insert Below to add the test to the sequence. The new test information appearsin
the Sequence Editor list box.

9. Next, add another test that uses a numeric limit specification, rather than a Boolean. Notice

that al the fields remain filled in. Because you are using the function Randomagain, you
need to make only afew changes. Change the Test Nameto Random Nuneri c.
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10. Click on Set Limit and set the Limit Specification to the numeric comparison, GELE, which
means greater than or equal to alower limit and less than or equal to an upper limit. Set the
lower limit to 0. 00 and the upper limit to 0. 50, as shown in the following illustration.

Comparison type:

GELE

Measurement must be

Figure 2-5. Setting Number Limits

11. Click on OK to accept the limit specification.
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12. Click on Insert Below to add this test after the Random Bool ean test. Your completed
test sequence should match the Sequence Editor list box shown in the following illustration.

= Test Executive Sequence Editor s
Test File Function Input Result Comp.
Randon-Foo random.ohb) Random {BOOL: + Edit I
Fandon-MNun random.aobj Random {GELE,0.0,0.5}
]
Test Attributes | Edit Paths . |
Test Name:
R andom-Numeric | M’
Function Name: File Name:
[Random | |t::'\t:vi'\teste::ec\e::am| Select File...
Limit Specification:
Input Buffer:
| | | Run Options. .. || Setup/Cleanup... I | Laneed it
Sequence Attnbutes oK I
| Test Preconditions.__ I | Deszcription. . ” Setup/Cleanup. . || Report._.. I
Cancel I H

Figure 2-6. A Completed Test Sequence Setup

13. To modify the definition of atest, click on the test you want to modify in the Sequence
Editor list box. Then click on Edit. The specifications of the test appear in the Test
Attributes controls (the Test Name, Function Name, Input Buffer, Limit Specification, Run
Options and Setup/Cleanup dialog boxes). Make any changes and click Apply Editsto
overwrite the existing information.
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Setting Preconditions
In the following steps you set up a dependency between the two tests in your sequence.

1. Click onthe Test Preconditions button. The Precondition Editor window appears.

= Test Executive Precondition Editor bl

Tests: Preconditions: Insert Position:

Randon-Eoolean [+ * Below [ [ Above
Randon-Numeric

| Add Condition... |

| Addanor |

| Addangor |

] [»]

‘ Delete Condition I

| Clear Conditons I

| 0K |

E‘ E‘ | Cancel I

Figure 2-7. Precondition Editor

2. Specify that Random Bool ean must passfor Random Nuner i ¢ to execute. Click on
Random Nuneri c inthe Testslist box. Click on Add Condition.... The Add Condition
dialog box appears.
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3. Inthe Add Condition dialog box, set the Type switch to PASS and click on Random Bool ean
inthe Testslist box. A check mark appears beside the name. Click on OK .

Type:
PASS [ [ FAIL

kd T F!.iﬁndl:lm—Eil:ll:llEEI

Figure 2-8. Using Add Condition to Set Preconditions

The Preconditions list box now shows PASS Random Bool ean. Thissignifiesthat
Random Nurmer i ¢ runsonly if the precondition test Random Bool ean passes.

= Test Executive Precondition Editor x| -
Tests: Preconditions: Insert Position:
Random-Boolean #|| iPASS Randow-Eoolean * Below [ [ [ Above

Fandon-Numeric

| Addanor |

| Addangor |

] [»]

‘ Delete Condition I

| Clear Conditons I

Figure 2-9. A Completed Random-Boolean Precondition Setup

4. Click on OK to save the new dependency specification and return to the Sequence Editor.
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Running the Sequence
Y ou are now ready to run your test sequence.

1. Return to the main Test Executive front panel by clicking on OK . The new test sequence
appears in the Sequence Display.

2. Click onthe Test UUT button to run the sequence. The Test Executive automatically
determines if the test passes or fails based on the values transmitted in thet Test Dat a
structure. Perform the following steps to see your specification in action.

a After you have tested several UUTS, click on the Stop button in the UUT Information
dialog box.

b. Select View from the Report menu to see the data generated for each test by the
Randomfunction.

3. Choose Exit from the File menu to quit the Test Executive. The application automatically
prompts you to save the sequence you created. Do not save your changes.

The three examples presented in this chapter show the fundamental operationsin the Test

Executive: developing test functions and using the Sequence Editor to create sequences that use
these functions. The remaining chapters describe the Test Executive in greater detail.

Example Sequences

The Test Executive package includes four test sequence examples located in the EXAMPLES
subdirectory of the Test Executive. The four sequences, COMMENT. SQU, COMPUTER. SQU,
RTERROR. SQU, and PREPOST. SQU, demonstrate different aspects of the Test Executive.

COMVENT. SQU executes tests that use the outBuffer field to log test results in a customized
format. When you run COMVENT. SQU, the Test Report contains multiple, custom-formatted
lines rather than the standard formatted lines.

COMPUTER. SQU includes setup and cleanup functions (functions that run before or after atest
or test sequence), multiple dependencies, and tests that use a variety of comparison types.

RTERROR. SQU contains the same tests as COMPUTER. SQU, but generates a run-time error
during the test to illustrate the Run-time Error dialog boxes.

PREPOST. SQU demonstrates the different levels of setup and cleanup functions.
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Operating the Test Executive

This chapter shows how to use the Test Executive main panel—the controls, indicators, and
operator dialog boxes. The main panel isthe user interface for both development and run-time
operation. The following illustration shows the Test Executive main panel when you are at the
Developer level.

= ah dn B P B -

-file Report Sequence Test

Descnption: Sequence File: Login Level: 10-14-07
|Simulates testing a computer motherboard. | |computer.squ | [Developer | 09-21-1994

Seqguence Display: Test Display:

Poyer 0On + +
ROM

RAM

Video

Kevboard

ROM Diagmostics

FAM Diagnostics
Video Diagnostics
Kevboard Diagnostics

B E 5]

| Test UUT I Fidvensd | Run Test I
|

Loop Test | J Stopped

D Stop on Failure | Clear Test Status I

| Single Pass I fibnt | ong

Figure 3-1. Test Executive Main Panel

Featur es of the Main Panel

The menu items, buttons, and other controls on the Test Executive main panel access the
following three areas of operation.

» Seqguence file operations and login
* Execution
* Display

The following sections describe how the Test Executive controls operate.
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File Menu
Login

Choose the L ogin menu item from the File menu to enter a new user name and/or password.
Y ou can access the Login menu at any operating level.

New

The New menu item del etes the current sequence and clears the Test Executive Sequence
Display so that you can create a new test sequence. If you have modified the current sequence,
the Test Executive prompts you to save changes before loading the new sequence. Y ou can use
the New menu item only in the Developer operating level.

Open...

Select Open... from the File menu. The File dialog box should appear on your screen. Use this
box to load a test sequence into memory from afile. Selecting avalid sequence file deletes the
current sequence in memory and loads the new sequence into the Test Executive. If you have
modified the current sequence, the Test Executive prompts you to save changes before loading
the new sequence.

Save

The Save menu item saves the current test sequence. Y ou can use the Save button only in the
Developer operating level.

SaveAs...

Choose the Save As... menu item and the File Dialog box appears on your screen. This box
saves atest sequenceto file. The File Dialog box prompts you with the pathname of the
sequence currently in memory, if that sequence has a pathname. Y ou can use the Save As...
button only in the Developer operating level.

Exit

The Exit menu item causes the Test Executive to stop execution. |f you have modified the

current sequence, the Test Executive prompts you to save your changes before quitting. Y ou can
access the Exit menu item in any operating level.
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Report Menu

Clear

The Clear menu item removes the current test report from memory. Clear does not erase the
report file. You can accessthe Clear menu item in any operating level.

View

The View menu item displays the current test report in the Test Display text box. Only the 20
most recent sequence passes display. Y ou can choose the View menu item from any operating
level.

Sequence Menu

Edit Sequence...

The Edit Sequence... menu item invokes the Sequence Editor. Y ou can access the Edit
Sequence... menu item only in the Developer operating level.

Test Menu

Nor mal

The Nor mal menu item sets the run mode of the selected test to normal. Y ou can use the
Normal menu item only in the Developer or Technician operating level.

Forceto Pass

The For ceto Pass menu item sets the run mode of the selected test to Forceto Pass. You can
see the Forceto Pass menu item only in the Developer or Technician operating level.

Forceto Falil

The Force to Fail menu item sets the run mode of the selected test to Forceto Fail. You can
access the For ce to Fail menu item only in the Developer or Technician operating level.
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ip

The Skip menu item sets the run mode of the selected test to Skip. You can use the Skip menu
item only in the Developer or Technician operating level.

Note: Changing the run mode using Normal, Forceto Pass, Forceto Fail and Skip is

equivalent to using the Sequence Editor. If you use these menu items at the Devel oper
level, the Test Executive prompts you to save the sequence beforeit is unloaded.

Main Pandl Controls

Test UUT

The Test UUT button starts a repetitive execution of the test sequence for UUT testing. (Seethe
Execution Model section in Chapter 1, Introduction, for information about the Test UUT mode
of execution.) You can use the Test UUT button from any operating level.

Single Pass

The Single Pass button executes the test sequence onetime. (See the Execution Model sectionin
Chapter 1, Introduction, for information about the Single Pass mode of execution.) Y ou can
access the Single Pass button only in the Developer and Technician operating level.

Abort

The Abort button stops sequence execution after the current test completes execution. If you
start testing by clicking on the Test UUT button, clicking on Abort stops testing on the current
UUT. The system then prompts you for the next UUT serial number. The Abort buttonis
available at all operating levels, but is active only when atest is running.

Abort Loop

Clicking on the Abort L oop button stops the loop execution. Test sequence execution then
continues with the next test. Y ou can use the Abort L oop button only when the Test Executive
loops on atest. You can accessthe Abort L oop button from any operating level.

Run Test

The Run Test button executes the test selected in the Sequence Display. Y ou can use the Run
Test button only in the Developer and Technician operating levels.
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Loop Test

The Loop Test button starts a repetitive execution of the test currently selected in the Sequence
Display list box. You can only accessthe Loop Test button from the Developer and Technician
levels. When you select L oop Test, the following dialog box appears.

m ﬂﬁ_ times

[ ] Stop if test FAILs

| 0K I | Cancel I

Figure 3-2. Loop Test Dialog Box

Y ou can execute a specific number of iterations, with the option to stop if the test fails. To
specify the number of iterations, enter the number of iterations in the Loop count control. The
preceding figure shows aloop that will iterate five times. If you want looping to stop when the
test fails, click on the Stop if test Fails check box. To confirm your inputs, click on the OK
button. To cancel, click on Cancel.

Stop If Test Fails

When you select Stop if test Failsin the Loop Test dialog box, sequence execution stops when
any test fails. You can access the Stop if test Fails box from any operating level.
Stop on Failure

When you select the Stop on Failure check box on the main panel of the Test Executive, the
execution of test sequences stops every time atest fails.

Clear Test Status

The Clear Test Status button clears the Test Status/Result field for each test in the Sequence
display. You can accessthe Clear Test Status button in all operating levels.
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| ndicators

This section describes the displays and indicators found on the Test Executive front panel.

Sequence Description

The Description indicator displays a description of the sequence, if available, above the
Sequence Display.

Sequence File

The Sequence File indicator appears above the Test Display. If no sequenceisloaded, or if you
have not saved the current sequence, thisareadisplays No Sequence. Otherwise, the
Sequence File indicator displays the base filename of the test sequence.

Login Level

The Login Level indicator appearsto the right of the Sequence File indicator and shows the
current login level.

Sequence Display

The Sequence Display shows the list of testsin the loaded test sequence as shown in the
following illustration.

Sequence Display:

P Power On Pazs +
3 ROM Skip

FAM Pass=

Video Fass
F Kevboard Fail

FOM Diammostics None

FAM Diamnostics tkip

Video Diagnostics Ikip

Kevhoard Diagnostics HNone

+]

Figure 3-3. Sequence Display List Box
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Each display line contains three fields. The fields in the Sequence Display are not labeled, so
take special note of what field occupies each part of theline. From left to right, the fields are the
run mode, Test Name, and Test Status/Result.

The run mode field indicates the setting of the run mode parameter for the test. The following
table shows the available run mode values and their meanings.

Table 3-1. Run Mode Fields

Value M eaning

blank (no symbol) | Test will run normally.

S Test will be skipped.

P Test will be skipped with aforced PASS resuilt.
F Test will be skipped with aforced FAI L result.

The Test Name field shows the name of the test.

The Test Status/Result field is set to RUNNI NG during test execution to indicate the active test.
After the test completes, the field reflects the result of thetest. The following table shows the
possible Test Status/Result field values and their meanings.

Table 3-2. Test Status/Result Fields

Value Meaning

PASS Test result satisfied limit specification.

FAI L Test result did not satisfy limit specification.

SKI P Test did not execute.

NONE Test data was logged but no comparison was made because
the limit specification was set to Log only.

ERROR Run-time error occurred during test execution.
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Test Display

The Test Display shows three types of information.
* Result of each test

* Error messages

* Test report

The Test Display appears as shown in the following illustration.

Test Diusplay:
Wideo Diagnostics NONE +
Measurement: 0.0
no adapter present
K
. [+]

Figure 3-4. Test Display

Result of Each Test

After atest executes, the Test Display shows the complete result of that test. The format of atest
result is as follows.

Test Name Resul t
Comment (optional, may be multiple Iines)
Measur enent Conparison Lower Limt Upper Limt

Notice that the number of lines that comprise the test result varies, depending on the type of
comparison made and whether or not atest logs a comment. A test result always contains at
least one line listing the name and result of thetest. The result isthe same value shown in the
Test Status/Result field of the Sequence Display.
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The specific test that logged a comment determines format and content of the Comment line(s).
The Measurement field shows the measured value returned by the test. Comparison shows the
type of limit checking used to determine whether the test passed. The Condition for Test to Pass
column in the following table shows the lower and upper limit values used for pass/fail
determination. The possible values of Comparison and their relation to the Lower and Upper
Limits (Condition for Test to Pass) appear in the following table.

Table 3-3. Lower and Upper Limits

Comparison Condition for Test to Pass

EQ Measurement = Lower Limit

NE Measurement != Lower Limit

Gr Measurement > Lower Limit

LT Measurement < Upper Limit

CE Measurement >= Lower Limit

LE M easurement <= Upper Limit

GILT Measurement > Lower Limit and < Upper Limit
CELE Measurement >= Lower Limit and <= Upper Limit
GELT Measurement >= Lower Limit and < Upper Limit
GILE Measurement > Lower Limit and <= Upper Limit

Error Messages

When the Test Executive detects arun-time error, it displays a description of the error in the Test
Display.
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The Test Report

You can aso view the Test Report in the Test Display. The Test Report records the testing
results for the execution of atest sequence. The following segment of monospaced text shows
the format of a Test Report.

TEST REPORT

Sequence Nane: c:\testexec\ exanpl es\ comput er. squ

Descri pti on: Simul ates testing a computer notherboard.
Tests Power On, ROM RAM Vi deo, and Keyboard.
Then runs di agnostics for any areas which fail.

Dat e: 08- 09- 1994

Ti me: 10: 48: 42

Qper at or: John Smith

R I o S R

UUT Serial Nunber: 1

Power On PASS
ROM PASS
RAM PASS
Vi deo PASS
Keyboard PASS
ROM Di aghosti cs SKI P
RAM Di agnosti cs SKI P

Vi deo Di agnostics SKI P
Keyboard Di agnostic SKIP

UUT Serial Nunber: 2

Power On PASS
ROM FAI L
RAM FAI L
Vi deo FAI L
Keyboard FAI L
ROM Di aghosti cs NONE

Measurenment: 5.0
Access Error:
ROM Bank 5
RAM Di aghosti cs NONE
Measurenent: 5.0
Parity Error:
RAM Bank O
Vi deo Di agnostics NONE
Measurenent: 5.0
no adapter present
Keyboard Di agnostic NONE
Measurenment: 5.0
Keyboard not found
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Status

The Status indicator, directly below the Test Display, shows the current operating status of the
Test Executive. The possible values of the Status indicator and their meanings are as follows.

Table 3-4. Status Indicator Values

Value M eaning

STOPPED No test sequence currently running.
RUNNI NG Test sequence is running.
LOOPI NG Test sequenceis looping on atest.

Operator Dialog Boxes

During operation of the Test Executive, several dialog boxes appear that require user action.
This section describes these dialog boxes and their actions.

Login

The Login dialog box, shown in the following illustration, prompts the operator for Login Name
and Password.

= CV¥l Test Executive Login
Login Name:
T —
Password:
— |

Figure 3-5. Login Dialog Box

Type the appropriate Password to set the desired operating level. The CVI Test Executive dialog
box appears when the operator launches the Test Executive and when the operator selects the

L ogin menu item from the File menu. Click on the OK button to confirm the entries made in the
Name and Password inputs. Click on the Cancel button to remove the dialog box without
making any changes to the existing name and password. If you click on Cancel in the Login
dialog box when the Test Executive first starts running, the Test Executive exits.
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UUT Information

The UUT Information dialog box prompts you to enter a serial number for the device to be tested
on the next execution of the test sequence.

= UUT Information

[Enter UUT Serial Number:
919-PKT] |

Figure 3-6. UUT Information Dialog Box

The UUT Information dialog box appears only when you use the Test UUT button. The serial
number can be any ASCII string you choose. Click on the OK button to confirm the seria
number. Click on Stop to stop UUT testing.
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Pass, Fail, and Abort Banners

The Pass, Fail, and Abort banners, shown in the following illustrations, indicate whether the
current UUT passed or failed. The Pass, Fail, or Abort banner appears at the end of test
sequence execution for asingle UUT. One of these banners appear only when you initiate
testing by clicking on the Test UUT button. Press <Enter> or click OK to acknowledge the
banner and continue testing.

Test Sequence Aborted

Figure 3-7. The Pass, Fail, and Abort Banners

Run-Time Error Warning

A Run-time Error dialog box appears when atest reports an error. Two types of Run-time Error
dialog boxes can appear. The general Run-time Error dialog box is shown in the following
illustration.

Run Time Error in test YideoTest [in file cl\cviltestexeclexamplesirterror.obj]

Figure 3-8. General Run-Time Error Dialog Box
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The dialog box shown in the following illustration appears when arun-time error occurs and you
have specified a cleanup function for the test sequence. This prompt appears so the operator can
choose whether to run the cleanup function.

= Sequence Stopped

Current sequence stopped by run-time error or test failure.

Hun the sequence cleanup?

Figure 3-9. Run-Time Error Dialog Box for Cleanup Function
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Creating Testsand Test Sequences

This chapter describes the process of creating new functions and sequences for execution by the
Test Executive.

Writing Test Functions

To use the datalogging and error reporting capabilities of the Test Executive, you must design
tests as C functions with afixed prototype. Y ou include these functions in your own source code
files. You can add your source code files to the project (t est exec. prj ) and then take
advantage of the debugging features of LabWindows/CVI. When you finish debugging, you can
create object modules from these source code files and remove the source code files from the
project file. Y ou can create the object modulesin LabWindows/CV1 or using the Watcom,
Borland, or Symantec 32-bit C compilers. Test functions should have the following prototype:

voi d Sanpl eTest (t TestData *data, tTestError *error);

Test Data Structure

A test function uses the Test Data structure to transmit data results that the Test Executive uses
to determineif atest passed or failed. The Test Data structure is defined in the following way.

typedef struct TestData {
Status result;
doubl e neasurenent;

char *inBuf fer;
char *out Buf f er;
char *modPat h;
char *nmodFi | e;
voi d *hook;

} tTestData;
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The Test Data structure contains the elements named in the following table.

Table 4-1. Elements of the Test Data Structure

Chapter 4

Name Type M eaning

PASS/FAIL Flag Status | Set by test function to indicate whether test
passed or failled (Thisflag is observed only
if the test has been set to pass or fail based
upon a Boolean comparison.)

M easurement double- Measurement value used for Test

precison | Executive Pass/Fail evaluation

inBuffer string String passed in by Test Executive

outBuffer string String returned by test function

modPath string Directory path of file containing test
function

modFile string File name of file containing test function

hook generic Additional user defined data

pointer

The Test Executive allocates and frees an input buffer when oneis specified for the test. The test
function must allocate the outBuffer if needed, but the Test Executive freesit. If your test
function needs to access another filein itsdirectory (suchasa . ui r file), you can usethe
modPath and modFile fields to construct the file name. These fields help you avoid problems if
you later move the module containing the test. The hook parameter provides away to pass
arbitrary datato the test function. The Test Executive ignores the hook parameter.

Test Error Structure

A test function reports errors with the t Test Er r or structure. The Error structure is defined in

the following way.

t ypedef struct TestError {
Bool ean errorFl ag;

tErrLoc errorlLocation;

int errorCode;
char *errorMessage;

} tTestError;
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Thet Test Er r or structure contains the following elements.

Table 4-2. Elements of the Error Structure

Name Type M eaning
errorFlag Bool ean |Trueif an error occurred, False otherwise
errorLocation t Err Loc |Reserved for Test Executive interna use.

Where error occurred (in the test function
itself, or one of the setup/cleanup functions)

errorCode integer | 0if no error, non-zero to indicate specific
error
errorMessage string Text description of error

The Test Executive uses the contents of the Error structure to determineif arun-time error
occurred and takes appropriate action.

Creating Setup and Cleanup Functions

Setup and cleanup functions are specia functions for test system configuration, such as turning
on avacuum pump or shutting down power supplies. In general, the setup and cleanup functions
always execute, regardless of the status of any test. If the setup or cleanup function encounters a
situation that prevents the test sequence from executing, it indicates the condition as arun-time
error. Setup and cleanup functions do not log data; they only return run-time error information.

Sample Test Templates

The Exanpl es directory contains a collection of sample test templates to help you get started
developing your tests. Each test template shows how to use particular features of the test
executive, including methods for both Boolean and limit test development, assigning error codes
and messages to test operations, passing messages back to the test executive, and using buffer
information passed into atest. For new test development, we strongly recommend that you start
with one of the test templatesin the Exanpl es directory to ensure smooth integration into the
test executive.

Creating or Editing A Test Sequence

Y ou use the Sequence Editor of the Test Executive to create atest sequence containing your
tests. In the Sequence Editor, you can configure the run options and test preconditions that
control the flow of your test sequence. Y ou also specify the name of the test function and the file
inwhich it exists.
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To create or modify atest sequence, you must choose Edit Sequence... from the Sequence
menu when the Test Executiveis at the Developer operating level. This section describes the
operation of the Sequence Editor. The following illustration shows the Sequence Editor.

= Test Executive Sequence Editor 'l -

Test File Function Input Result Comp.

Fower 0On computer.ohj FPowerOnTest {BOOL} + #gd
RON computer.ohj ROMTest {BOOL} ¢
AN computer,obhj EiAMTest {BOOLY

Video computer,.oby WVideoTest {BOOLY

Kevhoard computer.obj FKeyboardTest |

ROM Diagno computer.ob) ROMDiagnostic {LOGY

BAM Diagno computer,ob] PBRaMDiagnostic {LOGY

Video Diag computer.ob)y WVideoDiagnost LLOGY

Kevbhoard D computer.oby EKevboardDiagn LLOGY

Test Attributes Edit Paths... I
Test Hame:
Function Mame: File Name: Insert Below I

[KepboardT est | |c:\cvi'\testexec\exam| Select File... I
Limit Specihication:

T —
Apply Edits

Input Buffer:

| || Run Options. .. || Setup/Cleanup... I | Cancel Edits I

Sequence Attributes —————————————
| Test Preconditions... I‘ ‘| Description... ” Setup/Cleanup. .. || Report... I

Figure 4-1. Sequence Editor Dialog Box
What Isa Test Sequence?
A test sequenceis acollection of datathat describes the flow of test execution. The main
component of atest sequenceisatest. A testisasingle execution step in the testing process. A

test executes a function to perform the required testing operation. The main components of atest
sequence are as follows.

e Listof tests

»  Setup/Cleanup functions

» Preconditions for flow control based upon Pass/Falil results
* Test report fileinformation

» Description of the sequence

Each of these components is explained in the following sections.
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What Isa Test?

A test contains a combination of specifications that tell the Test Executive how to perform a
single execution step in the testing process. A test consists of the following specifications.

* Name of test asit appears in the Test column of the Sequence Editor list box
» Function to execute

* Input Buffer containing data for test function

» Limit Specification for determining Pass/Fail status of test

* Run mode specifying whether or not test executes normally

» Fail and Pass Actions (and maximum loop count, if applicable)

Test Editing Operations

The controls grouped directly below the Sequence Editor list box are the test editing area. These
controlsinclude Test Name, Function Name, Select File, Set Limit, Run Options, Setup/Cleanup,
Insert Below, Insert Above, Replace, and Clear. Y ou use these controls for all operations related
to creating or modifying atest. You can add atest, modify atest, copy atest, and delete atest.
Adding a Test

Y ou can insert anew test above or below an existing test in the Test list box. Perform the
following steps to add a new test to a sequence.

1. Enter or select the desired values for Test Name, Function Name, Input Buffer, Limit
Specification, Run mode, and Setup/Cleanup.

2. Click onthetestinthe Test list box that is above or below the position where you want to
insert the new test.

3. Click on Insert Above or Insert Below to insert the test. If the Test list box contains no tests,
the new test appears asthe first test in the Test list box.

Modifying a Test

Perform the following steps to modify atest.

1. Click onthetest to edit in the Test list box.

2. Click onthe Edit button. The name of the test you selected now appears in the Test Name
string.
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3. Enter or select the desired values for Test Name, Function Name, Input Buffer, Run mode,
and Setup/Cleanup.

4. Click onthe Apply Edits button to make the modifications.

Copyinga Test

To copy atest, perform the following steps.

1. Click onthetest to copy inthe Test list box.

2. Click on the Copy button.

3. Select thetest in the Test list box that is above where you want to put the test you copied.
4

. Click on the Paste button.

Deletinga Test
To delete atest, perform the following steps.
1. Click onthetest you want to delete from the Test list box.

2. Click on the Cut button.

Sequence Editor Controlsand Indicators

This section describes the controls and indicators on the Sequence Editor front panel.

Edit

The Edit button selects the test highlighted in the Test list box for editing. If the highlighted test
isagoto, the Edit Goto dialog box appears. Otherwise, the controlsin the Test Attributes area
are set to the values for the test.

While you edit atest, the Edit, Cut, Copy, Paste, and Insert Goto buttons are dimmed, meaning
you cannot select them. Y ou can use the Apply Edits and Cancel Edits buttons. The Test list
box islocked. Thisuser interface is known as Edit Test mode.

Cut

The Cut button copies the test highlighted in the Test list box to the clipboard and del etes the test
from the test sequence.
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Copy

The Copy button copies the test highlighted in the Test list box to the clipboard but does not
delete the test from the test sequence.

Paste

The Paste button pastes the test in the clipboard below the test highlighted in the Test list box.

Insert Goto

Click on the Insert Goto button to open the Insert Goto dialog box. Here, you can add a goto to
your test sequence. The following illustration shows the Insert Goto dialog box.

= Insert Goto
Goto Target:
|[Keyboard Diagnostics |E,

Inzert Position:

ﬂlnsert Below | | 1].4 I | Cancel I

Figure 4-2. Insert Goto Dialog Box

Goto Target

Type the name of the test you want in the Goto Target control. For your convenience, you can
click on the arrow to the right of the Goto Target control to see alist of the tests currently
defined in the test sequence.

Insert Position

This control determines where the goto is inserted.

Note: Goto statements can have preconditions that determine whether they execute, just like
atest. You can specify these preconditionsin the Preconditions Editor.
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Edit Paths

Chapter 4

The Edit Paths button opens the following dialog box. Here you can change all the paths stored
in the sequence. This helps you update the paths when the sequence changes.

= Edit Paths

[Current Paths in 5equence:

c:\cviltestexechexamplesicomputer. obj

c:\cviltestexechexam

| Update Selected File... |

Pathnames After Changes:

+|c:hcviltestexechexamples\special.rpt

]

| oK I | Cancel I

Figure 4-3. Edit Paths Dialog Box

Current Pathsin Sequence

Thislist box show all the unique paths currently in the sequence.

Update Selected File...

Update Selected File... opens afile dialog box where you can specify a new path.

Pathnames after Changes

The Pathnames After Changes list box shows the new pathnames that the Test Executive uses. A
check mark appears to the right of the name after a new name has been selected with Update
Selected File.... The Pathnames After Changeslist box is an indicator only.
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OK

The OK button saves any changes you make to the test sequence, including preconditions, and
returns you to the Test Executive main panel.

Note: Your changes are not saved to the test sequence file when you click on OK. To save
the changes to disk, select the Save menu item on the Test Executive front panel.

Cancd

The Cancel button discards any changes you make to the test sequence and returns you to the
Test Executive main panel.

Test Attributes Area

Y ou use the controlsin the Test Attributes area to specify individual testsin the test sequence.

Test Name

Type any ASCII string in the Test Name box. The name appears in the Sequence Display of the
Test Executive main panel when the sequenceisloaded. Make sure you name each Test Name
uniquely.

Function Name

Type the name of the test function in the Function Name box.

File Name

Type the name of the file containing the test into the File Name control. You can also click on
the control labeled Select File... to open the File dialog box for specifying the file name.

Limit Specification

The Limit Specification specifies the type of limit checking the Test Executive usesto determine

if atest passes. You cannot type directly into the Limit Specification indicator. To specify a
limit, click on the Set Limits... button next to the Limit Specification indicator. Then use the
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increment/decrement buttons to set the comparison type and the measurement. The illustration
that follows shows the Set Limits dialog box.

Comparizon type:

EQ

Meazurement muszt be

Figure 4-4. Set Limit Dialog Box

Comparison Type specifies the type of comparison to perform, if any, to determine if atest
passed. Select the desired limit type from the Comparison Type ring control. The meaning of
each value of Comparison Typeisasfollows.

Table 4-3. Comparison Type Values

Comparison Condition for Test to Pass

Type

EQ Measurement == Lower Limit

NE Measurement != Lower Limit

Gr Measurement > Lower Limit

LT Measurement < Upper Limit

GE Measurement >= Lower Limit

LE M easurement <= Upper Limit
GILT Measurement > Lower Limit and < Upper Limit
CELE Measurement >= Lower Limit and <= Upper Limit
CGELT Measurement >= Lower Limit and < Upper Limit
GILE Measurement > Lower Limit and <= Upper Limit
BOOL Measurement not used, test return PASS/FAIL status
LOG No PASS/FAIL determination—measurement is logged
NONE No PASS/FAIL determination or datalogging
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Depending on the setting of Comparison Type, zero, one-limit, or two-limit entry controls appear
in the Set Limit Specification dialog box. A one-limit value appears for Comparison Types of
EQ NE, GT, LT, GE, or LE. Asshown inthe following illustration, two-limit values, alower and
upper limit, appear for Comparison Typesof GILT, GELE, GELT, or GTLE. No limits appear
for Comparison Types of BOOL, LOG, or NONE.

= Set Limits

Companson type:

$/GELE

Measurement must be

Qancel

Figure 4-5. Comparison Type Settings

Input Buffer
The Input Buffer isastring that is passed into atest function. The content and meaning of the

string are determined by the test function. Enter the desired input string into the Input Buffer
control.
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Run Options

The Run Options button opens the Test Run Options dialog box. Here you can specify the Run
Mode, Fail Action, Pass Action, and the maximum number of loops for atest. The Test Run
Options dialog box is shown in the following illustration.

= Test Run Options
Bun Mode:
e‘ Mormal |
Eail Action:
Loom
Loop Max. Loops:
Paszz Action: ﬂ—‘E
Mext Test
(1] 4 | Cancel I

Figure 4-6. Test Run Options Dialog Box
Run Mode

Run mode specifies whether the test executes normally. The options for Run mode and their
meanings are as follows.

Table 4-4. Run Mode Options

Run Mode Meaning
Normal Execute test normally.
Skip Do not execute the test; set result to SKIP.
Force Pass Do not execute the test; set result to PASS.
Force Fail Do not execute the test; set result to FAIL.
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Fail Action

Fail Action specifies an action to take when the test fails. The options for Fail Action and their
meanings are as follows.

Table 4-5. Fail Action Options

Fail Action Meaning
Next Test Continue execution with next test.
Loop Repeat execution of the test.
Stop Stop execution of sequence.

Pass Action

Pass Action specifies an action to take when the test passes. The options for Pass Action and
their meanings are as follows.

Table 4-6. Pass Action Options

Pass Action M eaning
Next Test Continue execution with next test.
Loop Repeat execution of the test.
Stop Stop execution of sequence.

Max. L oops
The Max. Loops control appears only when Fail Action or Pass Action isset to Loop. Max.

L oops specifies the maximum number of loop iterations to perform when, for example, the Fail
Actionissetto Loop, and the test fails.
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Setup/Cleanup

The Setup/Cleanup button invokes the Setup/Cleanup dialog box for an individual test. The
Setup/Cleanup dialog box appearsin the following illustration.

= Test Setupf/Cleanup Routines
Setup/Cleanup
Function Mame File Hame Input Buffer
Setup [YYD2860_Init | [e-\pydi\ppd2B60._ob || Select File I | |
Cleanup  YYD2860_Close  |||c-\pydypd2860_obj | setectFile | | |

Eanl:EI

Figure 4-7. Setup/Cleanup Dialog Box

Setup Function

The setup function executes before the test. Enter the name of the setup function in the Function
Name control. Enter the name of the file containing the function in the File Name control, or
click on the Select File button to open the File dialog box, where you can select the file you
want. If the Function Name control is left blank under setup, no setup Function runs. (Seethe
Writing Test Functions section at the beginning of this chapter for a note about writing your
setup function.)

Cleanup Function

The cleanup function executes after the test. Enter the name of the cleanup function in the
Function Name control. Enter the name of the file containing the function in the File Name
control, or click on the Select File button to open the File dialog box, where you can select the
fileyou want. If the Cleanup Function Name control is left blank, no cleanup function runs.
(Seethe Writing Test Functions section at the beginning of this chapter for a note about writing
your cleanup function.)

Insert Above

The Insert Above button inserts the test described in Test Attributes above the test that is
selected in the Test list box. If you are working in Edit Test mode, I nsert Above ends Edit Test
mode.

LabWindows/CVI Test Executive Toolkit 4-14 © National Instruments Corporation



Chapter 4 Creating Tests and Test Sequences

Insert Below

The Insert Below button inserts the test described in Test Attributes below the test that is
selected in the Test list box. If you are working in Edit Test mode, Insert Below ends Edit Test
mode.

Clear

The Clear button setsall controlsin the Test Attributes areato their default values. This button
also sets the controlsin the Set Limits, Run Options, and Setup/Cleanup dialog boxes to their
default values.

Apply Edits

The Apply Edits button replaces the test currently selected in the Test list box with the test
described in Test Attributes. Apply Edits ends Edit Test mode.

Cancd Edits

The Cancdl Edits button ends Edit Test mode without changes.

Test Preconditions

The Test Preconditions button invokes the Precondition Editor. See the Editing Preconditions
section later in this chapter for more information on editing preconditions.

Sequence Attributes

The controlsin the Sequence Attributes area are used to specify the description, setup/cleanup
functions, and report file for the test sequence.

Description

The Description button displays the dialog box shown in the following illustration, where you
can enter and modify the description of the test sequence. This description appearsin the Test
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Report that is generated when the test sequence is executed. The first line of the description also
appears in the Description box on the Test Executive main panel.

= Test Sequence Description

Only First line of descrption appears on operator panel.

imulates testing a computer motherboard. +
Tests Power 0On, ROM, RAM, Video, and Kevboard.
Then runs diagnostics for any areas which fail.

Eance‘

Figure 4-8. Test Sequence Description Dialog Box

Setup/Cleanup

The Setup/Cleanup button opens the Sequence Setup/Cleanup Routines dialog box. There are
two types of setup/cleanup functions available. Sequence setup/cleanup functions run at the
beginning and end of each sequence execution. Sequence load/unload functions run when the
sequence is loaded or unloaded. The Sequence Setup/Cleanup Routines dialog box appearsin
the following illustration.

= Sequence SetupfCleanup Routines

—5Sequence Execulion

Function Hame File Hame Input Buffer

Setup NYD2860_Clear | |c:'\t:\ri\testexec\examples\cnn| Select File I| |

Cleanup | | [ | Select File || |

—S5equence Load/Unload

Function Name File Hame Input Buffer
Setup YYD2860_Power | |c::'\t:vi\testexec\examples\cun| Select File I 11 |
[Cleanup | YYD2860_Powe] | |t::'\cvi'\testexec\examples\cnn| Select File I ] |

| 1] .9 I | Cancel I

Figure 4-9. Sequence Setup/Cleanup Dialog Box
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Report...

You click on the Report... button to set the attributes of your Test Report. Type the name of the
report file you want to create in the Test Report File control. You can click on the Select File...
button to open the File dialog box, where you can select the name of the report. When you set
Report File Mode to Append the Text Executive will add your report to the end of an existing
report. Choose Overwrite to replace the existing report file. Select Lock File Name to prevent
users from changing the name of the report file. The Set Default Report File dialog box appears
in the following figure.

= Set Default Report File
Test Report File:

ez veviltestexec\examplesicomputer. ipt | Select File._. I

Report File Mode:
E Append & Lock File Mame

Overwrite

| 1] I | Cancel I

Figure 4-10. Set Default Report File Dialog Box
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Editing Preconditions

Chapter 4

The preconditions of a particular test specify what other tests must pass or fail before that
particular test executes. Y ou can use the Precondition Editor shown in the following figure to
define the preconditions of tests.

Test Executive Precondition Editor

Tests: Preconditions:
Power On + ALL OF: +
ROM PASS Power 0On
RAM FATL ROM
Video
Keyhoard

FOM Diammostics
FAM Diagnostics
Video Diagnostics
Kevboard Diagnost

Inzert Fosition:
Below [ | I Above

| Add Condition._. |

| Addanor |

| Addangor |

B3

| Delete Condition I

|<(<I

| Clear Conditons I

| 0K |

| Cancel I

Figure 4-11. Precondition Editor

The Precondition Editor shows preconditions for a selected test. In the Tests list box, the name
of each test in the test sequence appears. One of the test namesin the Tests list box is aways
highlighted. The Preconditions list box shows the precondition tests—those tests on which test
execution depend—for any test name you select. In the illustration above, Power On test and
ROM test are the preconditions for ROM Diagnostics. ROM Diagnostics only runs when Power
On test passes and ROM test fails.

Take the following steps to specify the preconditions for a test.

1.
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Click on Add Condition....
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a Click on Add All Of when all of the preconditions you specify must be true.
b. Click on Add Any Of when at |east one of the preconditions must be true.

C. Youcanasonest ALL OF: and ANY CF: to create more complex preconditions.

Click inthe Tests list box to select atest. If you want multiple preconditions, group them
under ALL OF: or under ANY CF: .
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In the Add Condition dialog box, set the Type switch to PASS or FAIL , depending on
whether you want the precondition test to pass or fail. Then select the precondition test
from the Testslist box, and click on OK'. Y ou can select multiple precondition tests from
the Tests list box. The setting of the Type switch determines the pass or fail setting of the
next precondition test that you select. The letter P beside atest name indicates a pass
Setting.

F indicates afail setting.

3. Continue adding conditions until you complete the desired settings.
Y ou can use the other controls on the Precondition Editor as follows.

» Thelnsert Position switch determines whether new preconditions will be inserted before or
after the current precondition.

* The Add All Of buttoninserts ALL OF: to begin ablock of preconditions which must all be
true.

» The Add Any Of button inserts ANY OF: to begin ablock of preconditions of which at least
one must be true.

* The Add Condition... button brings up the Add Condition dialog box, shown in the
following illustration.

Tests:
Type:

~ P Power On +
ROM PASS .:|:| FAIL

FAM
Video

F EKevhoard
EOM Diammostil
FAM Diagnosti |
Video Diagnos

0K |

+ | Cancel I

Figure 4-12. Add Condition Dialog Box

* TheTestslist box shows the available precondition tests. The Type switch allows you to
specify whether the precondition test must pass or fail.
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The Moveto theleft and Moveto theright buttons (shown in the following figure) alow
you to adjust the level of the currently selected precondition. In general, Add Condition
sets the level properly, so you should seldom have need of the Move to the left and Moveto
theright buttons.

L Fx

Figure 4-13. Move to the Left Button and Move to the Right Button

The Delete Condition button deletes the selected precondition.

The Clear Conditions button clears al of the preconditions for the test selected in the Tests
list box.

The OK button saves any changes made to the test sequence preconditions and returns you to
the Sequence Editor.

Changes you make to preconditions take effect only when you click on the OK button in the
Sequence Editor. All preconditions are saved with the test sequence when you select Save from
the menu on the Test Executive main panel to save the test sequence to disk.

The Cancd Edits button discards any changes made to the test sequence preconditions and
returns you to the Sequence Editor.

Relationship between Preconditions, Run Mode,
and Test Flow

The preconditions and run mode for each test determine the test execution flow for a test
sequence. The Test Executive performs the following steps to determine whether or not to
execute a given test.

1. The Text Executive evaluates the preconditions for the test. For atest to execute, the result

of each precondition test must match the result specified in the preconditions. If evaluation
of preconditions indicates that the current test should be skipped, the test result is set to
SKI P.

LabWindows/CVI Test Executive Toolkit 4-20 © National Instruments Corporation



Chapter 4 Creating Tests and Test Sequences

2. The Test Executive checks the Run mode of thetest. If the Run modeis Nor mal , the test
executes. If Run mode is set to any value except Nor mal , the test does not execute. Table
4-7 shows the value that each Run mode generates for a skipped test.

Table 4-7. Run Mode Test Result Vaues

Run Mode |Value Generated
Skip SKI P
Force PASS | PASS
Force FAIL |FAIL

When the Text Executive evaluates preconditions, it does not distinguish between areal PASS or
FAI L result—where the test actually executed—and aforced PASS or FAI L result.
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Modifying the Test Executive

This chapter describes the internal structure of and how to modify the Test Executive. When you
need to go beyond the standard Test Executive functions, you can refer to the information in this
chapter. This chapter explains the organization of the Test Executive so that you can change the

behavior of the application when you need to. The chapter covers the following topics.

* Organization of source code files
¢ Common modifications
* Advanced modifications

» Writing atest executive

Organization of Source Files

The Test Executive contains several source codefiles. The following table lists the name and
use of each file. More detailed descriptions of each file appear after the table.

Table5-1. List of Filesin the Test Executive

t xengi ne. c

File Name FileUse

t xmai n. c Test Executive Main Panel

t xedseq. c Sequence Editor

t xedpc. ¢ Precondition Editor

txlogin.c Login Panel

t Xxprecnd. c Evaluate, load, save preconditions
t xreport.c Create and save report

t xsavres. c Maintain history of test results
cvitxuir.uir |Userlinterface

Maintain, load, and save sequences,
run tests

© National Instruments Cor poration
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t xrmai n. ¢ isthe main source code file for the Test Executive. In addition to controlling the
other modules, t xmai n. ¢ handlesthe Text Executive front panel. The function mai n()
handles initialization and starts the user interface. Thereafter, the Test Executive makes
extensive use of callbacks. The important callbacksint xmai n. ¢ are Mai nPanel Cal | back
and Mai nMenuCal | back which handle al the menus and controls on the front panel. A
major task of t xmai n. ¢ isrunning tests. In particular, RunTest UUT, Si ngl ePass,
LoopTest , and RunSi ngl eTest arefunctionsint xmai n. ¢ that handle the running of
tests.

t xedseq. ¢ handles the Sequence Editor panel and its popup dialog boxes. The function
SetupEdit starts the Sequence Editor. The main callback for the Sequence Editor is
SegEdCal | back. Each pop-up dialog box also has acallback: Got oCal | back,
RunOpt i onCal | back, Report Cal | back, Li mi t Cal | back,

Test PrePost Cal | back, SeqPr ePost Cal | back, Descr Cal | back, or

EdPat hsCal | back. The most important global variablein t xedseq. ¢ isthe array
gEdi t Dat a which contains the specification for each test in the sequence.

t xedpc. ¢ handles the Precondition Editor panel and its pop-up dialog boxes. The function
PE_Set upPr eCondEd starts the Precondition Editor. The main callback for the Precondition
Editor panel is Pr eCondEdCal | back. The Add Condition dialog box also has the callback
AddCondi ti onCal | back. Thearray variable sAl | Test PCAr r ay containsthe
preconditions for all tests.

Thefunction OpenLogi n int x| ogi n. ¢ handleslogin by users. Most importantly,
t x| ogi n. ¢ setsthe global variablegLogi nLevel which determines whether the Test
Executive isin Operator, Technician, or Developer operating level.

t xpr ecnd. ¢ handlesloading, saving, and evaluation of preconditions. The functions for
saving and loading preconditions are PC_Save and PC_Load. PC_Eval Precondi ti ons
evaluates the preconditions of atest. The array variable sSeqPr eConds containsthe
preconditions.

t Xxr eport . ¢ handlestest report generation. The major functionsare W i t eRpt Header ,
WiteSeqHeader ,and Wit eTest Resul t . Each string written to the report file also
becomes part of the global array gTest Report for use by the View command in the Report
menu. When gTest Report isfull, the system discards the oldest strings.

t xsavr es. ¢ maintainsarecord of current and previous test results. The Test Executive uses
the results for the current sequence when evaluating preconditions. Previous results go into a
history list as a starting point for users who want to add analysis of test results. The function
SR _SaveOneResul t storesthe results of one test with results for the rest of the sequence.

SR _Renenber Curr Resul t s copiesthe results for the most recent sequence execution to the
history list. SR _For get Cur r Resul t s discards the most recent sequence results. The array
curr Resul t s storesthe current results and the array seqResul t s storesthe history.

cvi t xui r. ui r contains the specifications for the user interface of the Test Executive.

t xengi ne. ¢ contains the functions that maintain, load, and save sequences, and run tests.
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Common M odifications

This section describes common modifications that you can make to the Test Executive. This
section covers the following aress.

* Built-in Customization

* Passwords

* Pass, Fail, and Abort banners
e UUT Serial Number prompt
* Test report

+ Standalone executables

Built-In Customization

Severa customization options are already included in the Test Executive. By defining or
undefining C language macrosin thefile cvi t xcst . h you can activate or deactivate these
options. See cvi t xcst . h for more information.

Changing Passwords

Y ou can set the passwords that determine operating level (Developer, Technician, and Operator)
according to your specifications by modifying the function CheckLogi n, found in

t x| ogi n. ¢ (the Operating Levels section in Chapter 1, Introduction, describes the operating
modes). Passwordsin CheckLogi n are case sensitive.

Changing Pass, Fail, and Abort Banners

Y ou can change the Pass, Fail, and Abort banners to display a banner that you design. On a
color monitor, the Pass, Fail, and Abort banners have a colored background (green for Pass, red
for Fail, yellow for Abort), an OK button, and alarge label containing the word Pass, Fail, or
Abort. These bannersare located in cvi t xui r. ui r and you can change them with the User
Interface Editor.

Changingthe UUT Serial Number Prompt

Y ou can also modify the panel that asks for the UUT serial number, which islocated in
cvi txuir. uir. If youadd controlsto this panel, you need to modify the function
RunTest UUT int xmai n. c.
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Y ou can al'so make other modifications to the serial number prompt, such as adding a routine that
reads the serial number from a bar code reader through an RS-232 port. Again, to make this
change you need to modify the function RunTest UUT.

Changing the Test Report

Thet xr eport . ¢ module generates the Test Report. The following illustration shows a
standard Test Report. Y ou can modify the test format of the Test Report to suit your needs.

TEST REPORT

Sequence Nane: c:\testexec\ exanpl es\ comput er. squ

Descri ption: Sinmul ates testing a conputer notherboard.
Tests Power On, ROM RAM Vi deo, and Keyboard.
Then runs di agnostics for any areas which fail.

Dat e: 08- 09- 1994

Ti nme: 10: 48: 42

Qper at or: John Smith

EIE R I I R O I R

UUT Serial Nunber: 1

Power On PASS
ROM PASS
RAM PASS
Vi deo PASS
Keyboard PASS
ROM Di agnosti cs SKI P
RAM Di aghosti cs SKI P

Vi deo Di agnostics SKI P
Keyboard Di agnostic SKIP

UUT Serial Nunber: 2

Power On PASS
ROM FAI L
RAM FAI L
Vi deo FAI L
Keyboard FAI L
ROM Di agnosti cs NONE

Measurenent: 5.0
Access Error:
ROM Bank 5
RAM Di agnosti cs NONE
Measurenent: 5.0
Parity Error:
RAM Bank O
Vi deo Di agnostics NONE
Measurenent: 5.0
no adapter present
Keyboard Di agnosti c NONE
Measurenent: 5.0
Keyboard not found

Several routines control the formatting of the report: Wi t eRpt Header , Wi t eSeqHeader ,
WiteTestResult ,WiteStopReason,and Wit ePrePost Qut Buf f er.
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Standalone Executables

The Test Executive Toolkit is shipped with a standal one executable of the Test Executive. You
may want to create your own standal one executable for any modifications you may make.

Y ou can also create a standalone executable to run a particular sequence by placing the full path
of the desired sequence file on the command line. If your standal one executable is intended for
operator use only, you can modify the function QpenLogi n int x| ogi n. ¢ to always set the
login level to operator.

Please refer to your LabWindows/CVI documentation for information about standalone
executables and the command line.

Advanced M odifications

The following section tells you how to make advanced modifications to the Test Executive:
changing preconditions and writing your own test executive.

Replacing the Preconditions

Y ou may want to replace the precondition processor. For example, you might prefer that each
test have aPass got 0o and aFail got 0. The steps you must take to replace the precondition
processor are relatively straightforward, for the following reasons.

» Thetest executive application calls the precondition module infrequently, so you can quickly
locate all the calls.

» The preconditions are appended to the end of the . squ file rather than being mixed in with
the rest of the test sequence.

» Thefunctions that save and load preconditionsare not int xengi ne. ¢, so you can change
them without changing t xengi ne. c.

To make replacements you need to make the following changes.

»  Writereplacement modulesfor t xedpc. ¢ andt xpr ecnd. ¢

* Replace precondition panelsincvi t xui r. uir.

» Changethefunction RunSequence int xmai n. ¢ to use your precondition replacement.
» Changet xedseq. ¢ to match your precondition replacement.

* Changecalsto TX SaveSequence and TX LoadSequence to passyour save and load
functions rather than PC_Save and PC_Load.
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Writing a Test Executive

The Test Executive Engine contains the support functions needed to write a test executive.
Chapter 6, Function Descriptions for the Test Executive Engine, describes the available
functions. Thet i nyexec directory containstwo example programs, ti ny_bl d. prj and
tiny_run. prj,whichillustrate the basic steps for writing atest executive. ti ny_bl d
shows you how create asequenceand t i ny_r un shows you one way to make a sequence
execute. For the sake of simplicity, both examples omit most error checking, ignore
preconditions, ignore pre/post tests, and support only the BOCL Limit Specification. When you
develop a Test Executive, you can add such features as needed.
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Function Descriptionsfor the Test Executive
Engine

This chapter describes the functions in the LabWindows/CV1 Test Executive engine. The
section called Test Executive Engine Overview contains general information about the Test

Executive engine functions. The Test Executive Engine Function Reference section presents
function descriptions in alphabetical order.

Test Executive Engine Overview

The Test Executive source code file contains a library of functions that perform many low-level
operations to maintain, load, and save sequences, and run tests. This library of functionsis called
the Test Executive engine.

Y ou can modify the Test Executive by editing the source code built on top of the Test Executive
engine library of functions. If you need to make fundamental changes to the application itself,
you can develop your own test executive application from scratch, using as a starting point the
Test Executive engine functions described in this chapter. Do not modify the functionsin the
Test Executive engine library functions unless you are an experienced C programmer with
thorough knowledge of test executive systems.
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The Test Executive Engine Function Panels

Chapter 6

The Test Executive engine function panels are grouped in the following tree structure according

to the types of operations they perform.

Table 6-1. Test Executive Engine Function Tree

Test Executive Engine
I nitialization/Reset
Restart Test Executive
Edit Test Sequence
Add Sequence Pre or Post Test
Add Test After Current Test
Add Test Before Current Test
Cut Test From Sequence
Paste Test After Current Test
Paste Test Before Current Test
Verify Test Sequence
Verify Test
Verify Sequence Pre/Post Test
Verify Sequence
Manipulate Current Test Pointer
Setthe CTPtoaTest
Move the CTP to the Next Test
Move the CTP to the Previous Test
Read/Modify Current Test
Get Information from the Engine
Change Settings in Engine
Run Tests
Run Current Test
Run Sequence Pre/Post Test
L oad/Save Sequence
Load a Sequence from Disk
Save a Sequenceto Disk
L oad/Save Support
Read Byte
Read Short Integer
Read Integer
Read Double
Read String
Write Byte
Write Short Integer
Write Integer
Write Double
Write String
Utility
Get Base File Name
Get File Directory
Duplicate String

TX RestartEngine

TX_AddPrePostTest
TX_AddTestNext

TX _AddTestPrevious
TX_CutTest

TX PasteTestNext
TX PasteTestPrev

TX VerifyTest
TX VerifyPrePostTest
TX VerifySequence

TX SetCurrTest
TX NextTest
TX PrevTest

TX_GetEnginel nfo
TX_SetEnginel nfo

TX RunTest
TX_RunPrePostTest

TX_LoadSequence
TX_ SaveSequence

TX_ReadByte
TX_ReadShort
TX_ReadInt

TX ReadDouble
TX_ReadString
TX WriteByte
TX_WriteShort
TX_Writelnt
TX_WriteDouble
TX_WriteString

TX_GetBaseFileName
TX GetFileDir
TX_StrDup
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The bold headings on the | eft side of the tree are the names of function classes and subclasses.
Function classes and subclasses contain groups of related function panels. The subheadingsin
plain text are the names of individual function panels. Each User Interface Library function
panel generates one function call. The name of each function call isto the right of its
corresponding function panel name in bold, italic text.

Descriptions of the function classes appear in the following list.

* Initialization/Reset functionsinitialize the Test Executive Engine.

» Edit Test Sequence functions add and remove tests from the current sequence.

* Verify Test Sequence functions load tests from external modules and verify that the tests
can berun.

* Manipulate Current Test Pointer functions alow changing the Current Test Pointer (CTP).

* Read/Modify Engine Information functions access sequence and test information stored in
the Test Executive Engine.

* Run Tests functions run tests.
* Load/Save Sequence functions|oad or save sequences.

» Utility functions provide utility routines.

Include Files

The Test Executive Engine provides an include file that contains function declarations and
defined constants for all of the library routines. Thisincludefile, named t xengi ne. h, must be
in al code modules that reference the Test Executive Engine.

Reporting Errors

Most of the functions in the Test Executive Engine return an integer code containing the result of
the call. If the return code is negative, an error occurred. |If the return code is greater than or

equal to zero, the function completed successfully. See Appendix A, Error Codes and Engine
Constants, for alist of error codes.

Test Executive Engine Function Reference

This section describes each function in the Test Executive Engine. The functions are arranged
alphabeticaly.
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TX_AddPrePostTest

i nt status = TX_AddPrePostTest (char *testName, char *testDescription,
char *fileNamefor TestModule,
char *functionNameofTest,
i nt executionTime, i nt testType);

Purpose
This function adds a pre- or post-test to the Test Executive Engine. You may specify that the test

run every time the sequence executes or that it run only when the system loads or unloads the
sequence.

Parameters
Input | testName string Name that uniquely identifies the test
testDescription | string Description that identifies the test more completely
fileName string | Path and file name for the module that contains the test

function

functionName | string Name of actual function in the module, specified by
the previous parameter

executionTime |integer [ If non-zero, the test runs only when the sequenceis
loaded or unloaded. If zero, the test runs every time
the sequence is executed.

testType integer | If non-zero, thetest isapre-test. If zero, thetestisa
post test.
Return Value
status integer | Refer to Appendix A for error codes.

TX_AddTestNext

i nt status=TX_AddTestNext (char *testName, char *testDescription,
char *testFileName, char *testFunctionName,
char *preTestFileName, char *preTestFunctionName,
char *postTestFileName, char * postTestFunctionName) ;
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Purpose

This function adds atest function into the test sequence. TX AddTest Next addsthe text
function after the test that the Current Test Pointer (CTP) pointsto. TX AddText Next then
increments the CTP.

Parameters
Input [ testName string | Name that uniquely identifies the test

testDescription string | Description that identifies the test more
completely

testFileName string [ Path and file name for the module that contains
the test function

testFunctionName string [ Name of the test function

preTestFileName string | Path and file name of the module that contains

the local pre-test function
preTestFunctionName | string | Name of the local pre-test function

postTestFileName string | Path and file name of the module that contains
the local post-test function

postTestFunctionName | string | Name of the local post-test function

Return Value

status integer | Refer to Appendix A for error codes.

TX_AddTestPrevious

i nt status=TX_AddTestPrevious( char *testName, char *testDescription,
char *testFileName, char *testFunctionName,
char *preTestFileName, char *preTestFunctionName,
char *postTestFileName,
char *postTestFunctionName) ;

Purpose
This function adds a test function into the test sequence. TX _AddTest Pr evi ous addsthe

Test Function before the test that the CTP pointsto. TX _AddTest Pr evi ous then decrements
the CTP.
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Parameters
Input [testName string | Name given to the test to more descriptively

identify the test

testDescription string | Description given to the test to more
descriptively identify the test

testFileName string | Path and file name for the module that contains
the test function

testFunctionName string [ Name of the test function

preTestFileName string | Path and file name of the module that contains

the local pre-test function
preTestFunctionName | string | Name of the local pre-test function

postTestFileName string | Path and file name of the module that contains
the local post-test function

postTestFunctionName | string | Name of the local post-test function

Return Value

status integer | Refer to Appendix A for error codes.

TX CutTest
int TX CutTest (void);

Purpose

This function will remove the test pointed to by the Current Test Pointer and storeitin an
internal clipboard. You may reinsert thetest using TX Past eTest Next or
TX Past eTest Prev.

Note: When you cut a test and the clipboard already holds a test, then the previous test islost.

Return Value

status integer | Refer to Appendix A for error codes.
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TX_GetBaseFileName
char *baseFileName = TX_GetBaseFileName ( char *fullPathName) ;
Purpose

This function returns a copy of just the file name from the full path name of afile.

Parameters
Input | fullPath string | Thefull path name of afile
Return Value
baseFileName string [ A copy of the file name found in the full path name

TX_GetEnginelnfo

i nt status=TX_GetEnginelnfo (unsi gned short fied, voi d * newValue) ;

Purpose

Returns information stored in the Engine and/or in the test that the Current Test Pointer points to.

Notice that the data returned is only a copy of the actual datain the engine. Modifying the return
value does not affects the data inside the engine.

Parameters
Input | field short Indicates what information to get. Refer to Appendix A
integer | for valid fields.
Output | newValue void Pointer to returned information. Caller responsible for
freeing memory used by this value.
Return Value
status integer | Refer to Appendix A for error codes.
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TX_GetFileDir
char *fileDirectory = TX_GetFileDir (char *fullPathName) ;
Purpose

This function returns a copy of the directory from the full path name of afile.

Parameters
Input | fullPath string | Thefull path name of afile
Return Value
fileDirectory string | A copy of the directory name for afile

TX_LoadSequence

i nt status=TX_LoadSequence ( char *fileName, voi d *specialL oadFunction) ;

Purpose
L oads atest sequence.
Parameters

Input [ fileName string The name (and drive/path) for the file containing

the test sequence to be loaded
specialL oadFunction | function | Pointsto afunction for loading additional
pointer | information. See Parameter Discussion.

Return Value

status integer | Refer to Appendix A for error codes.

Parameter Discussion

specialL oadFunction allows you to set up afunction to load additional datathat the Test
Executive Engine did not load. For example, the Test Executive normally uses this function to
load the preconditions. This function allows you to add extensions without having to modify the
engineitself. Thisspecial load function has the following prototype:

i nt SpecialLoadFunc(i nt fileHandle, i nt numTests)
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fileHandle is the handle of the open sequence file and numTests is the number of testsin the
sequence.

TX NextTest
i nt status=TX_NextTest(voi d);
Purpose

Moves the Current Test Pointer (CTP) to the next test in the test sequence. If the CTPis
currently at the end of the list, the CTP does not change, but an error code is returned.

Return Value

status integer | Refer to Appendix A for error codes.

TX PasteT estNext

i nt status = TX_PasteTestNext(voi d);

Purpose

This function inserts the test that is stored in the clipboard after the test that the CTP points to.

Return Value

status integer | Refer to Appendix A for error codes.

TX_PasteTestPrev
i nt status=TX_ PasteTestPrev(voi d);
Purpose

This function inserts the test that is stored in the clipboard before the test that the CTP points to.
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Return Value

status integer | Refer to Appendix A for error codes.

TX PrevTest
int status=TX_ PrevTest (voi d);
Purpose

Moves the Current Test Pointer (CTP) to the previous test in the test sequence. If the CTPis
currently at the beginning of thelist, the CTP remains there the function returns an error code.

Return Value

status integer | Refer to Appendix A for error codes.

TX_ReadByte
i nt status=TX_ReadByte(i nt fileHandle, char * byteRead) ;
Purpose

This function reads a byte value from the specified open file.

Parameters
Input [fileHandle integer | The handle of an open file from which the function
reads the value
Output | byteRead pointer | Pointer to the byte value that the function reads from
to thefile
char
Return Value
status integer | Refer to Appendix A for error codes.
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TX_ReadDouble
i nt status=TX_ ReadDouble(i nt fileHandle, doubl e * doubleRead) ;

Purpose

Function Descriptions for the Test Executive Engine

This function reads a double-precision value from the specified open file.

Parameters
Input | fileHandle integer | The handle of an open file from which the function
reads the value
Output | doubleRead pointer | Pointer to the double-precision value that the function
to reads from thefile
double-
precision
Return Value
status integer | Refer to Appendix A for error codes.
TX_ ReadInt

i nt status=TX_ReadInt(i

Purpose

nt fileHandle i nt *intRead) ;

This function reads ainteger value from the specified open file.

Parameters
Input | fileHandle integer | The handle of an open file from which the function
reads the value
Output | intRead integer | Pointer to the integer value the function reads from the
file
Return Value
status integer | Refer to Appendix A for error codes.
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TX_ReadShort

i nt status=TX_ReadShort(i nt fileHandle, i nt *shortRead) ;
Purpose

This function reads a short integer value from the specified open file.

Parameters
Input | fileHandle integer | The handle of an open file from which the function
reads the value
Output | shortRead short Pointer to the short integer value the function reads
from thefile
Return Value
status integer | Refer to Appendix A for error codes.
TX _ReadString

char *theString = TX_ReadString(i nt fileHandle, i nt * gatus) ;
Purpose

This function reads a string from the specified open file.

Parameters
Input | fileHandle integer | The handle of an open file from which the function
reads the value
Output | status integer | Refer to Appendix A for error codes.
Return Value
theString char The string read from thefile.
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TX_RestartEngine
i nt status=TX_RestartEngine (voi d);
Purpose

Thisfunction initializes the Test Executive Engine. If thereisatest sequence currently in the
Engine when you call this function, that sequence is deleted.

Note: This function does not warn you that there is a sequence in the Engine. You must
save the test sequence before calling thisfunction. See TX _SaveSequence for
more information.

Return Value

status integer | Refer to Appendix A for error codes.

TX _RunPrePost Test

i nt status = TX_RunPrePostTest (void *testData, void *testError, i nt executionTime,
int testType);

Purpose
Runs atest prior to or after a sequence. Parameters specify that the test run every time the

sequence runs or that it run only when the system loads or unloads the sequence. The parameters
also set up the test as a pre- or post-test.

Parameters
Input/ [ testData tTestData Pointer to structure containing the test
Output (Seelndex.) |data. See Parameter Discussion.
testError tTestError Pointer to structure returning error
(Seelndex.) |information. See Parameter Discussion.
Input | executionTime integer If non-zero, the test runs only when the
sequence is loaded or unloaded. If zero,
the test runs every time the sequence is
executed.
testType integer If non-zero, thetest isa pre-test. If zero,
the test is a post-test.
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Return Value

status integer Refer to Appendix A for error codes.

Par ameter Discussion

Sequence pre- and post-tests can ignore the testData and testError structures.

TX _RunTest
i nt status=TX_RunTest (void *testData, void *testError, i nt *prePostTestError);
Purpose

Runsthe test that the CTP pointsto. If apre-test exists, it executesfirst. After the pre-test runs,
or if thereis no pre-test, the test executes. Finally, the post-test executes.

Parameters
Input/ | testData tTestData Pointer to structure containing the test data.
Output (SeelIndex.) | This pointer will be passed to the test function.
See Parameter Discussion.
testError tTestError Pointer to a structure for returning error
(SeelIndex.) [information from the test function. See
Parameter Discussion for more information.
Output | prePostTestError | integer Flag indicating an error occurred in the pre- or
post-test
Return Value
status integer Refer to Appendix A for error codes.

Par ameter Discussion

Thet est Dat a andt est Er r or structures can be ignored by pre and post-tests. They may
optionally be used to share data between the pre-test, test, and post-test functions.
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TX_ SaveSequence

i nt status = TX_SaveSequence (char * fileName, void * special SaveFunction);
Purpose

This function saves the current sequence in the specified file.

Parameters

Input | fileName string | The name (and drive/path) of the file where the
test sequenceis saved

special SaveFunction function | Pointsto afunction for saving additional
pointer |[information. See Parameter Discussion for
more information.

Return Value

status integer | Refer to Appendix A for error codes.

Parameter Discussion

Y ou can specify afunction to save additional data beyond what the Test Executive Engine saves
with the special SaveFunction parameter. For example, the Test Executive normally usesthis
function to save the preconditions. With this function, you can add extensions without having to
modify the engineitself. This special save function has the following prototype, where
fileHandle is the handle of the open sequence file and numTests is the number of testsin the
sequence.

i nt SpecialSaveFunc(i nt fileHandle, i nt numTests)

TX SetCurrTest
int status=TX_SetCurrTest (i nt testNumber);
Purpose

This function alows the Current Test Pointer to be moved to any test in the test sequence. The
index of this function begins at one (1).

Parameters

Input | testNumber integer | Index of the test where the CTP will point
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Return Value

status integer | Refer to Appendix A for error codes.

TX_SetEnginel nfo

i nt status = TX_SetEnginelnfo (unsigned short field, void *newValue);
Purpose

Copiesinformation into the Engine and/or into the test that the CTP points to.

Notice that this function copies the data that is sent to the engine and stores this copy inside the
engine. After you call thisfunction, you can modify the data element sent to the engine without
affecting the internally stored data.

Parameters

Input | field short | Specifieswhat information to set. Refer to Appendix A

integer | for valid fields.
newValue void Pointer to new value to be copied. Caller responsible
for freeing memory used by thisvalue

Return Value

status integer | Refer to Appendix A for error codes.
TX_StrDup

char *duplicate= TX_StrDup (char *src);
Purpose

This function creates a duplicate copy of the string pointed to by src and returns a pointer to the
new copy. TX St r Dup obtainsthe memory for the new string by using the mal | oc()
function and you can free the memory using the f r ee() function.

Parameters
Input |[src string | String to duplicate
Return Value
duplicate string | Pointer to new copy of string. Null if unsuccessful
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TX VerifyPrePostTest

i nt status=TX_VerifyPrePostTest (i nt executionTime, i nt testType, i nt *moduleld,
i nt *functionStatus,);

Purpose

This function verifies that the specified Sequence pre or post-test is available in the system.

Note: Thisfunction also loads the external module which contains the pre-test or post-test.

Parameters
Input [ executionTime integer If non-zero, the test runs only when the
sequenceis loaded or unloaded. If zero,
the test runs every time the sequenceis
executed.
testType integer If non-zero, thetest isapre-test. If zero,
thetest isapost test.
Output | moduleld integer Module ID number or error code. See
L oadExter nalM odule for error codes.
functionStatus integer Status of function pointer. See
L cadExter nalM odule for error codes.
Return Value
status integer Refer to Appendix A for error codes.

TX VerifySequence

i nt status=TX_VerifySequence (i nt *moduleld, i nt *functionStatus,
i nt *testFailingVerify);

Purpose

This function verifiesthat the local pre-test, post-test, and the main test functions are available in
the system for every test in the system.

Thetestsare verified in order. If any test fails the verification, the function halts and returns the
number of the test that failed.

This function does not verify the sequence pre- and post-test functions.
TX_VerifyPrePostTest() must be run separately.

© National Instruments Cor poration 6-17 LabWindows/CVI Test Executive Toolkit



Function Descriptions for the Test Executive Engine Chapter 6

Note: Thisfunction also loads the external module which contains the test functions.

Parameters
Output | modulel d integer Module ID number or error code. See
L oadExter nalM odule for error codes.
functionStatus integer Status of function pointer. See
L oadExter nalM odule for error codes.
testFailingVerify integer Index of first test which failed verification
Return Value
status integer Refer to Appendix A for error codes.
TX VerifyTest

i nt status=TX VerifyTest (i nt *moduleld, i nt *functionStatus)
Purpose

This function verifies that the local pre- post-test, and main test functions are available in the
system for the test pointed to by the Current Test Pointer.

Note: Thisfunction also loads the external module which contains the test functions.

Parameters
Output | modulel d integer Module ID number or error code. See
L oadExter nalM odule for error codes.
functionStatus integer Status of function pointer. See
L oadExter nalM odule for error codes.
Return Value
status integer Refer to Appendix A for error codes.
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TX_WriteByte
i nt status=TX_WriteByte(i nt fileHandle, char byteToWrite) ;
Purpose

This function writes a byte to the specified open file.

Parameters

Input | fileHandle integer | The handle of an open file to which the function writes
thevalue

byteToWrite string | Byte value to write to the specified file

Return Value

status integer | Refer to Appendix A for error codes.

TX_WriteDouble
i nt status=TX_WriteDouble(i nt fileHandle, doubl e doubleToWrite) ;
Purpose

This function writes a doubl e to the specified open file.

Parameters
Input | fileHandle integer | The handle of an open file to which the function writes
thevalue
doubleToWrite |double- | Double-precision value to write to the specified file
precision
Return Value
status integer | Refer to Appendix A for error codes.

© National Instruments Cor poration 6-19 LabWindows/CVI Test Executive Toolkit



Function Descriptions for the Test Executive Engine Chapter 6

TX_Writelnt

i nt status=TX_Writelnt(i nt fileHandle, i nt integer ToWrite) ;
Purpose

This function writes a double-precision integer to the specified open file.

Parameters

Input | fileHandle integer | The handle of an open file in which the function writes
the value

integer TOWrite |integer | Integer valueto write to the specified file

Return Value

status integer | Refer to Appendix A for error codes.

TX _WriteShort
i nt status=TX_WriteShort(i nt fileHandle, short shortToWrite) ;
Purpose

This function writes a short integer to the specified open file.

Parameters
Input | fileHandle integer | The handle of an open file to which the function writes
thevalue
shortToWrite short | Short integer value to write to the specified file
integer
Return Value
status integer | Refer to Appendix A for error codes.
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TX_WriteString

i nt status=TX_WriteShort(i nt fileHandle, char *stringToWrite) ;
Purpose

This function writes a string to the specified open file.

Parameters

fileHandle integer | The handle of an open file to which the function writes
thevalue

stringToWrite | char String to write to the specified file

Return Value

status integer | Refer to Appendix A for error codes.
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Error Codes and Engine Constants

This appendix lists the error codes and other important constants used by the Test Executive
engine. Seet xconst . ¢ for more information.

Error Codes

The following error codes are returned by functionsin the Test Executive engine.

Table A-1. Error Codes

Error Code Meaning

ERR _CLI PBOARD EMPTY Attempt to paste atest when the clipboard is
empty

ERR END OF LI ST Attempt to move past the beginning or end of
the sequence

ERR | LLEGAL_PO NTER Unexpected NULL value for pointer

ERR | NVALI D_ENG NE_ | NFO Constant passed to TX _Get Engi nel nf o or
TX Set Engi nel nf o isinvalid

ERR | NVALI D TEST MODULE Problem unloading external module

ERR LI M T_SPEC OQUT_OF_ RANGE The measurement comparison type for the
testisinvalid

ERR LI ST_EMPTY The sequence contains no tests

ERR LI ST_NOT_EMPTY The sequence containstestswhen it is
expected to be empty

ERR _LOCAL_POSTTEST_NOT_VERI FI ED | Attempt to execute unverified local post-test
ERR LOCAL_PRETEST_NOT_VERI FI ED | Attempt to execute unverified local pre-test

ERR_METAPOSTTEST_RUN_TI ME Run-time failure in sequence unload post-test
ERR METAPRETEST_RUN TI ME Run-time failure in sequence load pre-test
ERR _META POSTTEST_FAI L Sequence unload post-test failed

ERR META PRETEST_FAI L Sequence load pre-test failed

ERR_NEWER VERSI ON Sequence file version is greater than Test

Executive Engine version

(continues)
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Table A-1. Error Codes (Continued)

Error Code

M eaning

ERR_NOT_TX_FI LE
ERR_NO PRE_POST TEST

ERR_OUT_OF MEMORY
ERR_POSTTEST_FAI LED VERI FY

ERR _POSTTEST _RUN_TI MVE
ERR _PRETEST_FAI LED VERI FY

ERR_PRETEST RUN TI ME
ERR_PRE_POST_TEST EXI STS

ERR_READI NG FROM FI LE

ERR_SEQPOSTTEST_RUN_TI ME
ERR_SEQPRETEST RUN TI ME
ERR_SEQUENCE_POSTTEST_FAI L
ERR_SEQUENCE_PRETEST FAI L
ERR_TEST_FAI LED VERI FY

ERR _TEST_NOT_VER! FI ED
ERR_TEST_OUT_OF RANGE

ERR TEST_RUN Tl ME
ERR_UNABLE_TO OPEN FI LE
ERR WRI TI NG TO FI LE
NO_ERRCR

Fileisnot avalid sequencefile

Attempt to set or get information for
undefined local pre-test or post-test

Memory allocation attempt failed

Unableto verify local post-test. Usually due
to invalid file or function name

Run-time error in local post-test

Unableto verify local preest. Usually dueto
invalid file or function name

Run-time error in local pre-test

Attempt to define sequence pre-test or post-
test when one already exists

Error reading from file. Usualy dueto
unmatched modifications to

TX SaveSequence and

TX LoadSequence

Run-time error in sequence post-test
Run-time error in sequence pre-test
The sequence post-test failed

The sequence pre-test failed

Unableto verify test. Usually dueto invalid
file or function name

Attempt to execute unverified test

Attempt to set invalid test number with
TX Set Curr Test

Run-time error in test
Unable to open file
Error writing to file

No error
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Engine Information Constants

Error Codes and Engine Constants

The following constants are used by TX Set Engi nel nf o and TX_Get Engi nel nf o to

choose the information to set or retrieve.

Table A-2. Engine Information Constants

Constant Type Meaning

| NFO_GENERAL_STRI NG char * [1] | The sequence genera purpose
expansion string

| NFO_GOTO_TARGET int* The index in the sequence of the
test which is the destination of the
goto

| NFO_I S_GOTO short * A flag indicating whether the test is
agoto

| NFO_LOOP_COUNT int* The number of times the current
test has looped

| NFO_NMAX_LOOPS int* Maximum number of times a test
should loop

| NFO_METAPCSTTEST_NAMES char * [4] | The names associated with the
sequence unload post-test: file
name, function name, test name,
and test description

| NFO_METAPOSTTEST _PARAMETERS char * [1] | The parameter string for the
sequence unload post-test

| NFO_METAPRETEST_NAMES char * [4] | The names associated with the
sequence load pre-test: file name,
function name, test name, and test
description

| NFO_METAPRETEST_PARAMETERS char * [1] | The parameter string for the
sequence load pre-test

| NFO_POSTTEST_PARAMETERS char * [1] | The parameter string for the current
test’s post-test

| NFO_PRETEST PARAMETERS char * [1] | The parameter string for the current
test’s pre-test

| NFO_REPORT_FI LE_NAME char * [1] | The default name of the report file

| NFO_RPT_FI LE_LOCK short * Whether the operator can change
the name of the report file

(continues)
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Table A-2. Engine Information Constants (Continued)

Constant

Type

M eaning

| NFO_RPT_FI LE_MODE

| NFO_SEQPOSTTEST NAMES

| NFO_SEQPOSTTEST_PARAVMETERS

| NFO_SEQPRETEST _NAMES

| NFO_SEQPRETEST PARAVETERS
| NFO_SEQ DESCRI PTI ON

| NFO_SEQ FI LE_NAVE

| NFO_SI| ZE_ OF SEQUENCE

| NFO_TEST_DESCRI PTI ON

| NFO TEST_FAI L_ACTI ON

| NFO TEST LIM T_H GH

| NFO TEST LIM T_LOW

| NFO_TEST_NAMES

short *

char * [4]

char * [1]

char * [4]

char * [1]
char * [1]
char * [1]
int *

char * [1]

short *

double *
double *

char * [8]

The report file mode: O for
overwrite, 1 for append

The names associated with the
sequence post-test: file name,
function name, test name, and test
description

The parameter string for sequence
post-test

The names associated with the
sequence pre-test: file name,
function name, test name, and test
description

The parameter string for sequence
pre-test

The sequence description string

The file name of the sequence.
Used to detect when the sequence
has moved

The number of testsin the sequence

Description string for an individual
test

The action to perform if the current
test fails: LOOP_ACTI ON_CONT,
LOOP_ACTI ON_LQOOP, or
LOOP_ACTI ON_STOP

The upper value to compare the test
measurement against

The lower value to compare the test
measurement against

The names associated with an
individual test: file name, function
name, pre-test file name, pre-test
function name. post-test file name,
post-test function name, test name,
and test description
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Table A-2. Engine Information Constants (Continued)

Constant Type Meaning

| NFO_TEST_NUMBER int* Index of the current test

| NFO_TEST_PARANMETERS char * [1] | Parameter string for the current test

| NFO TEST_PASS_ ACTI ON short * The action to perform if the current
test passes:

LOOP_ACTI ON_CONT,
LOOP_ACTI ON_LOOP, or
LOOP_ACTI ON_STOP

| NFO_TEST_RUN_MODE short * Run Mode for the test:
RUN_MODE_NORMVAL ,
RUN_MODE_FORCE_PASS,
RUN_MODE_FORCE_FAI L, or
RUN_MODE_SKI P

| NFO_TEST_SPEC short * Type of comparison to make
against measurement returned by
test: SPEC_EQ SPEC_NEQ,
SPEC GT, SPEC_CE, SPEC LT,
SPEC LE, SPEC GTLT,

SPEC GELE, SPEC GTLE,
SPEC GELT, SPEC BOOL,
SPEC _LOG, or SPEC_NONE
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessary
to help us solve technical problems you might have as well as aform you can use to comment on
the product documentation. Filling out a copy of the Technical Support Form before contacting

National Instruments helps us help you better and faster.

National Instruments provides comprehensive technical assistance around the world. Inthe U.S.
and Canada, applications engineers are available Monday through Friday from 8:00 am. to
6:00 p.m. (central time). In other countries, contact the nearest branch office. Y ou may fax

guestionsto us at any time.

Corporate Headquarters
(512) 795-8248
Technical support fax: (800) 328-2203

(512) 794-5678
Branch Offices Phone Number
Austrdia (03) 879 9422
Austria (0662) 435986
Belgium 02/757.00.20
Denmark 4576 26 00
Finland (90) 527 2321
France (1) 48142400
Germany 089/741 31 30
Italy 02/48301892
Japan (03) 3788-1921
Mexico 95 800 010 0793
Netherlands 03480-33466
Norway 32-848400
Singapore 2265886
Spain (91) 640 0085
Sweden 08-73049 70
Switzerland 056/20 51 51
Taiwan 02 377 1200
U.K. 0635 523545
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Fax Number
(03) 8799179
(0662) 437010-19
02/757.03.11
45767111

(90) 502 2930
(1) 48 14 24 14
089/714 60 35
02/48301915
(03) 3788-1923
95 800 010 0793
03480-30673
32-848600
2265887

(91) 640 0533
08-73043 70
056/20 51 55

02 737 4644
0635 523154
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Technical Support Form

Photocopy this form and update it each time you make changes to your software or hardware, and use the completed
copy of thisform as areference for your current configuration. Completing this form accurately before contacting
National Instruments for technical support helps our applications engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem, include the
configuration forms from their user manuals. Include additional pages if necessary.

Name

Company

Address

Fax (___) Phone (___)

Computer brand Model Processor

Operating system

Speed MHz RAM MB Display adapter

Mouse yes no Other adaptersinstalled

Hard disk capacity MB Brand

Instruments used

Nationa Instruments hardware product model Revision

Configuration

National Instruments software product Version

Configuration

The problemis

List any error messages

The following steps will reproduce the problem




Documentation Comment Form

National Instruments encourages you to comment on the documentation supplied with our products. This
information helps us provide quality products to meet your needs.

Titlee  LabWindows®/CVI Test Executive Toolkit Reference Manual

Edition Date: November 1994

Part Number: 320863A-01

Please comment on the compl eteness, clarity, and organization of the manual.

If you find errors in the manual, please record the page numbers and describe the errors.

Thank you for your help.

Name

Title

Company

Address

Phone  ( )

Mail to: Technical Publications
National Instruments Corporation
6504 Bridge Point Parkway, M S 53-02
Austin, TX 78730-5039

Fax to:

Technical Publications

National Instruments Corporation
MS 53-02

(512) 794-5678
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A

Abort banner. See Pass banner.

Abort button, Test Executive main
pand, 3-4

Abort Loop button, Test Executive main
pandl, 3-4

adding new test functions, 2-8 to 2-10, 4-5

Apply Edits button, Sequence Editor, 2-10,
4-6, 4-15

C

Cancel Edits button, Sequence Editor, 4-15
CheckLogin function, 5-3
Cleanup function, 4-3, 4-14
Clear menu item, 3-3
Clear Test Status button, Test Executive
main panel, 3-5
COMMENT.SQU example, 2-13
Comparison Types
entering in Set Limit Specification
dialog box, 4-9 to 4-11
list of available types (table), 4-10
possible values displayed in Test
Display (table), 3-11
COMPUTER.SQU example, 2-3, 2-13
configuring limit specifications, 2-8, 4-9
to4-11
controls, Test Executive main panel
Abort button, 3-4
Abort Loop button, 3-4
areas of functionality, 3-1 to 3-2
Clear Test Status button, 3-5
Loop Test button, 3-5
Run Test button, 3-4
Single Pass button, 3-4
Test UUT button, 3-4
copying tests, 4-5, 4-6
creating test functions. See test functions,
creating.
customer communication, xi, B-1
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D

deleting tests, 4-5, 4-6
Description button and dialog box, 4-15
Developer operating level
capabilities, 1-5
changing password, 5-3
quitting Test Executive, 2-13
selecting, 2-2, 2-6
Development Moddl, 1-5
dialog boxes. See operator dialog boxes.
documentation
conventions used, xii
organization of manual, xi
related documentation, Xii

E

Edit button, Sequence Editor, 2-6, 2-10, 4-5
to 4-6
Edit menu item, 3-3
Edit Paths button and dialog box, 4-8
Edit Test Sequence functions
Add Sequence Pre or Post Test using
TX_AddPrePostTest, 6-4
Add Test After Current Test using
TX_AddTestNext, 6-4
Add Test Before Current Test using
TX_AddTestPrevious, 6-5
Cut Test From Sequence using
TX_CutTest, 6-6
Paste Test After Current Test using
TX_PasteTestNext, 6-9
Paste Test Before Current Test using
TX_PasteTestPrev, 6-9
editing
preconditions. See preconditions,
Preconditions Editor.
test sequences. See Sequence Editor;
test sequences.
error messages
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Index

Run-time Error dialog box, 3-14

shown in Test Display, 3-9
Error structure, Test

definition, 4-2

elements (table), 4-3
example test sequences, 2-13
EXAMPLES subdirectory, 2-13
Exit menu item, 3-2

F

Fail Action, Test Run Options dialog
box, 4-12
Fail banner. See Pass banner.
File Name field, Sequence Editor, 4-9
Force to Fail menu item, 3-3
Force to Pass menu item, 3-3
front panel. See controls; indicators;
operator dialog boxes.
function classes,
descriptions, 6-2
table, 6-1
Function Name field, Sequence Editor, 4-9

G
Goto Target control, 4-7
I

indicators, Test Executive main panel

Description, 3-6

Login Leve, 3-6

Sequence Display, 3-6to 3-7

Sequence File, 3-6

Status, 3-11

Test Display, 3-8 to 3-11
Initialization/Reset functions

Restart Test Executive using

TX_RestartEngine, 6-13

Input Buffer field, Sequence Editor, 4-11
Insert Above button, Sequence Editor, 4-14
Insert Below button, Sequence Editor, 4-15

Insert Goto button and dialog box, Sequence

Editor, 4-7

LabWindows/CVI Test Executive Toolkit

Insert Position control, Sequence Editor 4-7
installing Test Executive Toolkit, 1-1 to 1-2

L

Limit Specification indicator, Sequence
Editor, 4-9
limit specifications, configuring, 2-8, 4-9
to4-11
L oad/Save Sequence functions
Load a Sequence from Disk using
TX_LoadSequence, 6-8
Save a Sequence to Disk using
TX_SaveSequence, 6-15
L oad/Save Support functions
Read Byte using TX_ReadByte, 6-10
Read Short Integer using
TX_ReadShort, 6-12
Read Integer using TX_ Readint, 6-11
Read Double using
TX_ReadDouble, 6-11
Read String using TX_ReadString, 6-12
Write Byte using TX_WriteByte, 6-19
Write Short Integer using
TX_WriteShort, 6-20
Write Integer using TX_Writelnt, 6-20
Write Double using
TX_WriteDouble, 6-19
Write String using TX_WriteString, 6-
21
Login menu item, 3-2
Login dialog box
changing to Technician level, 2-4
entering name and password, 2-1 to 2-2
illustration, 2-2, 3-12
purpose and use, 3-12 to 3-13
Loop Test button, Test Executive main
panel, 2-4, 3-5. Seealso Max Loops
control.

M

manual. See documentation.

Max Loops control, 4-13. Seealso Test Run
Options dialog box.

Manipulate Current Test Pointer functions
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Set the CTPto aTest using
TX_SetCurrTest, 6-15
Move the CTP to the Next Test using
TX_NextTest, 6-9
Move the CTP to the Prev Test using
TX PrevTedt, 6-10
menu items, Test Executive main panel
File menu
Exit, 3-2
Login, 3-2
New, 3-2
Open, 3-2
Save, 3-2
SaveAs..., 3-2
Report menu
Clear, 3-3
View, 3-3
Sequence menu
Edit Sequence..., 3-3
Test menu
Forceto Fail, 3-3
Force to Pass, 3-3
Normal, 3-3
Skip, 3-4
modifying
Test Executive. See Test Executive,
modifying.
tests. See test sequences, editing.
passwords, operator level, 5-3

N

New menu item, 3-2
Normal menu item, 3-3

O

Open menu item, 3-2
operating levels. See Developer operating
level; Operator operating level; Technician
operating level.
operator dialog boxes
Abort banner, 3-13
Fail banner, 3-13
Login, 2-1to 2-2, 3-11 to 3-12
Pass banner, 3-13
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Index

Run-time Error, 3-13 to 3-14
UUT Information, 3-12

Operator operating level
capabilities (table), 1-5
selecting, 2-2

P

Pass Action, Test Run Options dialog
box, 4-13
Pass banner
description, 3-13
illustration, 3-13
modifying, 5-3
password
entering in Login dialog box, 2-2, 3-11
modifying, 5-3
selecting operating level, 2-2, 3-13
preconditions
definition, 4-18
editing, 4-18 to 4-20
setting test execution order, 4-20
relation to run mode and test flow, 4-20
saving changes, 4-20
setting (example), 2-11 to 2-12
Preconditions Editor
control buttons, 4-19 to 4-20
description, 4-18 to 4-20
illustration, 2-11, 4-18
PREPOST.SQU example, 2-13

Q

quitting the Test Executive, 2-5, 2-13

R

Random function
adding to new sequence, 2-7 to 2-12
code, 2-5
Read/Modify Current Test functions
Get Information from the Engine using
TX_GetEnginelnfo, 6-7
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Change Settings in Engine using
TX_SetEnginelnfo, 6-16
repeating tests. See Loop Test button.
report. See Test Report.
Report button, 4-17
results of test. See Test Display; Test
Report; Test Status/Result field.
RTERROR.SQU example, 2-13
Run Mode control, Sequence Editor. See
also Test Run Options dialog box.
options (table), 4-12
purpose, 4-12
relationship to preconditions and test
flow, 4-20
Run mode field, Sequence Display, 3-6
Run Options button, Sequence Editor, 4-12.
See also Test Run Options dialog box.

Run Test button, Test Executive main panel,

2-4,3-4
Run Tests functions
Run Current Test using
TX_RunTest, 6-14
Run Sequence Pre/Post Test using
TX_RunPrePostTest, 6-13
Run-time Error dialog box, 3-13 to 3-14
running test sequences, 2-3 to 2-5, 2-13
executing single tests, 2-4 to 2-5
using Single Pass mode, 2-4 to 2-5

S

Save menu item, 3-2
Save As... menu item, 3-2
Sequence Attributes. See Sequence Editor.
Sequence Display, Test Executive main
panel
illustration, 3-6
Run mode field, 3-7
Test Namefield, 3-7
Test Statusg/Result field, 3-7
Sequence Editor. See also test sequences,
editing.
adding tests, 4-5
buttons
Cancdl, 4-9
Copy, 4-7
Cut, 4-6
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Edit, 4-6
Edit Paths, 4-8
Insert Goto, 4-7
OK, 4-9
Paste, 4-7
copying tests, 4-6
deleting tests, 4-6
Fail Action, 4-13
illustration of panel, 2-7, 4-4
inserting new tests, 4-5
invoking, 2-6
modifying tests, 4-5to 4-6
Pass Action, 4-13
preconditions
editing, 4-18 to 4-20
relationship with run mode and test
flow, 4-20 to 4-21
Sequence Attributes
Description, 4-15
Setup/Cleanup, 4-16
Report, 4-17
Test Attributes
buttons
Apply Edits, 4-15
Cancdl Edits, 4-15
Clear, 4-15
Insert Above, 4-14
Insert Below, 4-15
Run Options, 4-12
Select File, 4-9
Set Limits, 4-9
Setup/Cleanup, 4-14
controls
File Name, 4-9
Function Name, 4-9
Limit Specification, 4-9
Input Buffer, 4-11
Test Name, 4-9
Test Preconditions button, Precondition
Editor, 4-15
Sequence File indicator, 3-6
Set Limits button, Sequence Editor, 4-9
to4-10
Set Limit Specification dialog box, 2-8,
2-9,4-10
Setup function, 4-3, 4-14
Setup/Cleanup button and dialog box,
Sequence Editor, 4-14
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Single Pass button, Test Executive main
pand, 2-5, 3-4
Single Pass mode
definition, 1-4
running entire test sequence, 2-4
Single Test execution
definition, 1-4
repeating tests, 2-4
running a specific test, 2-4
Skip menu item, 3-4
starting Test Executive, 2-1to 2-3
Status indicator, Test Executive main panel
location, 2-3
possible values (table), 3-11

T

technical support, B-1
Technician operating level
capabilities, 1-5
changing password, 5-3
selecting, 2-2, 2-4
test
definition, 4-4
specifications, 4-5
TESTEXEC subdirectory, 2-1
Test Attributes. See Sequence Editor.
Test Data structure
discussion, 2-5t0 2-6, 4-1to 4-2
elements (table), 4-1to 4-2
including in test functions, 4-1
Test Display
error messages, 3-9
illustration, 3-8
information contained, 3-8
Test Report, 3-10
test results, 3-8 to 3-9
Test Error structure
definition, 4-2
elements (table), 4-2
Test Executive Toolkit
execution model, 1-4
instalation, 1-1to 1-2
modifying
Pass, Fail, Abort banners, 5-3
passwords, 5-3
test reports, 5-4

© National Instruments Corporation

Index

UUT seria number prompt, 5-3
operating levels, 1-5
organization of functions and files, 5-1
to5-2
quitting, 2-5, 2-13
running test sequence, 2-3to 2-5, 2-13
executing single tests, 2-4
using Single Pass mode, 1-4, 24
Sequence Editor,
starting, 2-1 to 2-3
Status indicator, 2-3
test functions
creating, 2-5to 2-6, 4-1
using a Test Data structure, 4-1 to 4-2
using a Test Error structure, 4-2 to 4-3
Test Name control, Sequence Editor, 4-9
Test Name field, Sequence Display, 3-8
Test Preconditions button, Sequence Editor,
4-15
Test Report
example, 3-10
modifying format, 5-3
viewing in Test Display, 2-4, 3-9 to 3-10
writing to file, 2-4
Test Run Options dialog box
description, 4-12
Run Mode control, 4-12
Fail Action control, 4-13
Pass Action control, 4-13
Max Loops control, 4-13
test sequences
components, 4-4
definition, 4-4
editing
adding tests, 2-7 to 2-10, 4-5
configuring limit specification, 2-7
copying tests, 4-6
creating tests, 2-6
deleting tests, 4-6
invoking Sequence Editor, 2-6
modifying tests, 4-5
preconditions
editing with Preconditions
Editor, 2-11 to 2-12, 4-18
to 4-20
relationship with run mode and
test flow, 4-20
editing description, 4-15
example sequences, 2-13
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opening and running, 2-3 to 2-4 Get File Directory using
purpose and use, 4-4 TX_GetFileDir, 6-8

test sequences, editing. See also Sequence Duplicate String using TX_StrDup, 6-16

Editor. UUT Information dialog box, 3-12
Test Status/Result field, Sequence Display, UUT serial number prompt, changing, 5-3

3-6t03-7 UUT Test
Test UUT button, Test Executive main definition, 1-4

panel, 2-3, 2-13, 3-4 opening and running test sequence, 2-3
TX_AddPrePostTest, 6-4 to 2-4
TX_AddTestNext, 6-4 Test UUT button, 3-4
TX_AddTestPrevious, 6-5
TX_CutTest, 6-6
TX_GetBaseFileName, 6-7 vV
TX_GetEnginelnfo, 6-7
TX_GetFileDir, 6-8
TX_LoadSequence, 6-8 Verify Test Sequence functions
TX_NextTest, 6-9 Verify Test using TX_VerifyTest, 6-18
TX PasteTestNext, 6-9 Verify Sequence Pre/Post Test using
TX_PasteTestPrev, 6-9 TX_VerifyPrePostTest, 6-17
TX PrevTedt, 6-10 Verify Sequence using
TX_ReadByte, 6-10 TX_VerifySequence, 6-17
TX_ReadDouble, 6-11 View menu item, 3-3

TX_Readint, 6-11
TX_ ReadShort, 6-12
TX_ReadString, 6-12

TX_RestartEngine, 6-13 W

TX_RunPrePostTest, 6-13

TX_RunTest, 6-14 writing test functions. See test functions,
TX_SaveSequence, 6-15 creating.

TX_SetCurrTest, 6-15
TX_SetEnginelnfo, 6-16
TX_StrDup, 6-16
TX_VerifyPrePostTest, 6-17
TX_VerifySequence, 6-17
TX VerifyTest, 6-18
TX_WriteByte, 6-19
TX_WriteDouble, 6-19
TX_Writelnt, 6-20
TX_WriteShort, 6-20
TX_WriteString, 6-21

U

Utility functions
Get Base File Name using
TX_ GetBaseFileName, 6-7
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